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General Information
Allgemeine Benutzerinformationen

2 General Information

2.1 Licence Agreement
Access to the NIVUS WebPortal is made available under a licence agreement. The use includes the execution of 
the programs. The licence agreement defines what you may do with the NIVUS WebPortal and regulates warranty 
limitations and claims for damages.

Read the licence agreement thoroughly before you start working with the NIVUS WebPortal.

Access to the NIVUS WebPortal may not be lent or leased against payment. The resale of the access to a third 
party is not permitted. Decompiling, reverse engineering and reassembling NIVUS WebPortal as well as any other 
modification is not permitted.

2.2 Copyright
No part of this publication may be reproduced, transmitted, sold or disclosed without prior permission.

Violations oblige to compensation.

All rights reserved.

Copyright © 2023

NIVUS GmbH

Im Taele 2

75031 Eppingen

2.3 Disclaimer
The companies of the NIVUS-Group assume no liability

• for consequential damages resulting from a change in this manual. The companies of the NIVUS-Group reserve
the right to change the contents of the handbook including this disclaimer without prior notice.

• for errors and loss of data due to improper handling of the software and for any consequential damage resulting
from this.

• for errors, loss of data or problems resulting from insufficient knowledge of the operating system (Windows 8 or
Windows 10).

• for errors and loss of data due to a disrupted Internet connection.
• for errors and loss of data due to server failure.
• for errors and loss of data caused by customer hardware.

The companies of the NIVUS-Group therefore disclaim any warranty for the transmission of messages and
measured values.

The operator alone bears the risk.
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2.4 About this Manual
This software manual is part of the software and contains all information required for the intended use of the soft-
ware.

The following knowledge is presumed and hence will not be explained:
• Basic knowledge on the OS (Windows 8 or Windows 10) and particularly how to use it
• Basic control elements such as mouse, windows, buttons and similar

Observe the following notes:
• Read this software manual before you use the NIVUS WebPortal.
• Keep this manual in a place where it is always accessible to all users.
• Observe the safety information contained in this software manual.
• All Screenshots in this documentation are Application Examples. Depending on operating system, software 

version of installed tools, user rights and activated licences some representations may vary from the actual 
screens.

2.4.1 Writing Conventions

2.4.2 List of Abbreviations

Representation and Meaning Remark

Important Important information

Button Name of a button

Menu > Menu Point Menu selection
Path to a menu point

Menu Name of a menu point

Window Name of a window

System Output Value output by the system

User Entry Value to be specified or selected by the user

Cross-Reference Cross-Reference
within the document, linked

Directory > File Path to a directory or a file
or name of a file

[Value] Placeholder for an entry-based or application-based value

Abbreviation Meaning

PV Process Variable

SO Stormwater Overflow

SOT Stormwater Overflow Tank
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2.5 Support
Contact the NIVUS WebPortal support under:

• E-Mail: hotline@nivus.com
• Phone: +49 7262 9191-955
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NIVUS WebPortal: Grundlagen

3 NIVUS WebPortal
The NIVUS WebPortal is a data management system for storage and provision of measurement data. All data is 
saved in the cloud.

Abb. 3-1: NIVUS WebPortal

Functions

The NIVUS WebPortal provides functions for:
• Analysis of Measurement Data
• System Verification
• Data Forwarding
• Alerting
• Creation of Protocols

3.1 System Requirements
The user interface of the NIVUS WebPortal is web-based. You can call up the NIVUS WebPortal in a standard web 
browser (recommended: use Google Chrome, Internet Explorer is not supported). There is no need to install addi-
tional add-ons.
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3.2 Articles and Services
Note: The following information on articles and services applies to orders as of 2022. All information on articles 
and services from older orders can be found in the manual NIVUS WebPortal Rev. 03.
There are different service packages per measuring point in the NIVUS WebPortal. In the following table you will 
find the different articles, their inclusive services and the optional additional services.

Tab. 3-1: Articles and Services on a Measuring Point in NIVUS WebPortal

Service NIVUWEBCON1
NIVUWEBCON2

NIVUHUBCON1
NIVUHUBCON2 NIVUWEB NIVUHUB

Nivus SIM Card x x - -

SIM Card Licence x x x x

Measuring Point Licence x x x x

Message Book x - x -

E-Mail Alarming x - x -

SMS Alarming Additional Service
SNI0WEBPSMS - Additional Service

SNI0WEBPSMS -

Visualisation
(Process image required) x - x -

Process image with max. 20 
process variables, required for 
visualisation

Additional Service
SNI0BILD1000000 - Additional Service

SNI0BILD1000000 -

Hydrographs, basic functions x - x -

Files and Reports x - x -

Add-on for the logging of 
one-chamber stormwater treat-
ment plants (= creation of 
monthly and annual reports)

Additional Service
SNI0WEBPRUEB - Additional Service

SNI0WEBPRUEB -

Template for Excel-based 
reports with max. 20 process 
variables

Additional Service
SNI0BEREXCEL01 - Additional Service

SNI0BEREXCEL01 -

Remote access to devices with 
remote access function x x - -
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In the following table you will find the optional additional services for projects.

Further information on the services can be found in the current price list.

Related links
Activation of Licences for Additional Services

3.3 The Path to NIVUS WebPortal
If you order NIVUS devices with or without extra licences for the use of the NIVUS WebPortal you will receive an 
e-mail from NIVUS or your local distributor

• containing a link for initial access to NIVUS WebPortal. Use this link to create your own project.
• containing an overview on ordered devices and the according licences. These are available for you in the 

NIVUS WebPortal.

Once these conditions are fulfilled you can execute all further steps required for the use of the NIVUS WebPortal:

• Create your customer project in NIVUS WebPortal
• Add the ordered devices to your project
• Optional: activate licences for additional services

Related links
Create and open initial Project
Add new device
Activate Measuring Point or Device Licence

Tab. 3-2: Additional Services for Projects

Art.-No. Name Description

SIN0WEBMESSPROL Project Licence Licence for one additional project

SNI0WEBMESSSTEL Measuring Point Licence Licence for one additional measuring point

SNI0WEBMGRAPH Cross-Measuring Point 
Hydrograph Module

Extended editing options for charts at all measuring 
points of a project

SNI0WEBMPOVER Project Overview
Customer-specific visualisation as start screen for a pro-
ject in NIVUS WebPortal (process image SNI0-
BILD1000000 required)
Page 7
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3.4 Basic Information on NIVUS WebPortal

The basic variables of an application are:
• Plant
• Measuring Point
• Device
• Process Condition

These variables are represented in NIVUS WebPortal as follows:

Abb. 3-2: Basic Units in NIVUS WebPortal

3.4.1 Project
A project represents the plant (= sum of measuring points) in the NIVUS WebPortal. As soon as you have received 
the link for initial access from NIVUS you can create your customer project. The according devices re created by 
NIVUS in NIVUS WebPortal. You need to add these to the project.

You can extend your project by additional devices at any time. As soon as you place an order the according devices 
will be created by NIVUS which pertmits you to add them to the project.

In most cases one project per customer is sufficient. More projects can be created in NIVUS WebPortal if you 
should need to do so. Should you wish to use devices in more than one project it is possible to shift them between 
projects. Observe that you need to purchase additional licences to do this.

Related links
Create and open initial Project
Create Additional Project
Add new device
Shift Device

Tab. 3-3: Application - NIVUS WebPortal

Application Image in NIVUS WebPortal

Plant Project

Measuring Point Measuring Point / Measuring Point Configuration

Device Device

Process Condition Process Variable (PV)
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3.4.2 Measuring Point - Device
The device data are saved in NIVUS WebPortal related to a measuring point. The measuring point - 
device assignment determines on which measuring point the data is to be saved.

The basic version of a customer project assumes the fixed use of all devices on always the same measuring point 
each and includes

• all device configurations and all measuring point configurations according to your plant in NIVUS WebPortal,
• one assignment to a measuring point and one activated measuring point licence per device.

You need to
• purchase and activate licences for all desired extra services (e. g. process image).

You can use each device alternately on different measuring points (see figure below). Consequently, you can 
operate several measuring points with one device.

Abb. 3-3: Assignment Measuring Point - Device

In this case you need to
• purchase a measuring point licence for each additional measuring point,
• create each additional measuring point in NIVUS WebPortal,
• assign each device to the measuring point it is currently used with,
• purchase and activate a licence for each desired additional service at a measuring point (e. g. SMS alarming).

As a rule:
• Assignment Measuring Point : Device = 1 : 1
• Data can only be saved in NIVUS WebPortal when a device is assigned to a measuring point.
• If a device is for fixed use with a measuring point it must be assigned to a measuring point anyway.
• The process variables are attached to the measuring point. The measuring point configuration must correspond 

with the connected type of device to make sure that a process variable can be assigned to each device input. 
When configuring the measuring point, you must therefore specify the desired device type; the required process 
variables are then automatically created at the measuring point.

Important: The measuring point configuration includes the process variables for a certain device type. You can 
use a device on a measuring point that does not exactly match the measuring point configuration. In this case the 
data for which there is no assignment of device input to a process variable is lost.
Page 9
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Related links
Activation of Licences for Additional Services
Measuring Points
Devices

3.4.3 Process Variables

3.4.3.1 Basics on Process Variables
Process condition and process changes are represented by process variables (PVs) in the NIVUS 
WebPortal.

The value of a process variable at a certain point in time is the process value.

For different kinds of applications there are different kinds of process variable types.

Once you purchase devices with licences for the use with the NIVUS WebPortal devices and measuring points 
including the required process variables are created for you in the NIVUS WebPortal. Create additional measuring 
points with the required process variables yourself. You can call up and edit the configuration of process variables 
under Device Overview > Measuring Point Configuration.

Among other things, the PV configuration contains:
• Creation of messages from the process variable
• Creation of a remote alarm from a process variable
• Active-status of process variable
Note: A process variable is effective only as soon as it is activated.

Related links
Path to the Message Book Entry
Path to Remote Alarming
Configuration of Process Variables
Measuring Points
Page 10
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3.4.3.2 Types of PVs
There are different types of process variables for various kinds of applications.

3.4.3.3 Measuring Point Values and Device Values
Device values are values which have been internally created by a device.

Measuring point values are all device values from all devices which are registered in a measuring point and can 
be recorded and saved in NIVUS WebPortal. To achieve this one device each must be assigned to a measuring 
point and a process variable must be assigned to each device input at the measuring point.

Tab. 3-4: Types of Process Variables: Overview and Description

Representation Name Characteristics Use Availability

Measured Value Analog Input Recording and representa-
tion of measurement values

Standard PV, all 
devices

Message Digital Input

Recording and representa-
tion of messages (error, 
warning, operational, 
system messages)

Standard PV, all 
devices

Counter Counter

Recording and display of 
counter values (impulse 
counters, differential coun-
ters, integral counters)

Standard PV, all 
devices

Calculation value Calculated Value
Statistical evaluations from 
the process values of a 
process variable

Optional additio-
nal PV
Page 11
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3.4.4 Communication
In order to enable communication between NIVUS WebPortal and a device and to make data available 
for the user all requirements must be fulfilled.

Requirements for communication:
• The device parameters for communication with the NIVUS WebPortal have been set accordingly (see instruc-

tion manual / handbook of device).
• In the NIVUS WebPortal

- the device is assigned to a measuring point,
- process variables for all device inputs have been created on the measuring point,
- the process variables have been activated.

• Internet connection between the device and NIVUS WebPortal is established.

Requirements for data access in NIVUS WebPortal by the user:
• The user is activated.
• The user is authorised for the desired service (e. g. Visualisation Module).

Abb. 3-4: Requirements for Communication and Data Access
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3.4.5 Path to the Message Book Entry
Process variables can create message book entries. Several conditions must be fulfilled to create an 
entry in the message book. You define these conditions in the PV configuration.

A process variable can create a message book entry in the following cases:
• A digital process variable changes its value.
• An analogue process variable reaches, exceeds or falls below the defined message threshold (= limit value vio-

lation).

Prerequisites for the creation of message book entries:
• The process variable is activated.

Activate / deactivate process variables: PV configuration
• A reaction is assigned to a digital process variable.

Assign reactions to a process variable: PV configuration
• For an analog process variable there is at least one defined message threshold. The message threshold is 

assigned to a reaction.
Assign message thresholds to a process variable: PV configuration
Configuration of message thresholds: sub-section of PV configuration
Assign reactions to a message threshold: configuration of message thresholds

The following illustration shows the internal check mechanisms that result in an entry or no entry being generated 
in the message book.

Abb. 3-5: Creation of a message book entry from a process variable

All entries are saved in the message book (tab Measuring Points > view Alarms). Moreover, users can be 
informed via remote alarming.
Page 13
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3.4.6 Path to Remote Alarming
As soon as the process condition is changing, i.e. if a process variable changes its value and all requi-
rements for remote alarming have been met the alarm is triggered. This means that as soon as a certain 
event occurs the user will be informed accordingly via email and /or SMS. Several requirements need to 
be met in order to trigger remote alarming.

Prerequisites for Remote Alarming:

• The Alarms module is unlocked for the unit (additional service at extra charge).
• The process variable is activated.

Activate / deactivate process variables: PV configuration
• A reaction with active remote alarming is assigned to a digital process variable.

Assign reactions to a process variable: PV configuration
• For an analog process variable there is at least one defined message threshold. A reaction with active remote 

alarming is assigned to the message threshold.
Assign message thresholds to a process variable: PV configuration
Configuration of message thresholds: sub-section of PV configuration
Assign reactions to a message threshold: configuration of message thresholds

• The user account of the user is registered with a valid email address as user name, the account is activated 
and unlocked for remote alarming.
For remote alarming by e-mail: The user name is a valid e-mail address and remote alarming by e-mail is acti-
vated.
For remote alarming by SMS (additional service at extra charge): The user's telephone number is stored in the 
NIVUS WebPortal and remote alarming by SMS is activated.
Edit user: tab > User (administrator rights required)

The following image provides an overview on the internal test mechanisms used to determine whether remote 
alarming is triggered  or not.

Abb. 3-6: Path to Remote Alarming
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3.4.7 Authorisations
Some functions or actions are bound to certain authorisations, i. e. they can only be used or executed by authorised 
users. In the NIVUS WebPortal there are 2 authorisation levels.

Tab. 3-5: Authorisation levels in NIVUS WebPortal

Authorisation Level Authorisation for Notes

Administrator Rights

Edit user accounts and user authorisations
Create additional project (licence required)
Measuring point handling: create, move and 
link measuring points and devices
Activate Licences
Configure and perform remote access (only 
possible for devices with NIVUS SIM card and 
remote access function).

There can be any number of users 
with administrator rights in the pro-
ject. The user who creates the pro-
ject is automatically given 
administrator rights. This user can 
grant administrator rights to other 
users.

access rights 
Use and edit Visualisation, Hydrographs, 
Log, Measuring Point Configuration, Alarms 
or Files and Reports

Access rights can be assigned indi-
vidually.
Page 15
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Oberfläche und Arbeitsumgebung

4 Interface and Working Area

4.1 Start Screen
Abb. 4-7: NIVUS WebPortal: Start Screen

1 Menu Bar
2 Opens the language selection
3 Opens the colour selection of the user interface
4 Opens the imprint
5 Opens the Privacy Statement
6 Calls up the NIVUS Quick Support

Important: Execute the NIVUS Quick Support only if you have been requested to do so by a NIVUS service 
employee.

7 Opens the NIVUS WebPortal handbook or the NIVUS WebPortal video tutorials
8 Shows the connection status

Green: connected to server
Yellow: connected to server but no service available
Red: not connected to server

9 Projects List
10 Logged in user

Note: As soon as you have successfully logged in with the NIVUS WebPortal the menu bar additionally shows the 
project name and the user name.
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4.2 Main Screen
The NIVUS WebPortal opens its main screen in the > Measuring Points tab. The user interface is divided into 4 
main sections. 

Abb. 4-8: Main screen in the Measuring Points tab

1 Menu bar
2 Function Bar

For all users: Measuring Points tab
For users with administrator rights: Project and User tabs

3 Navigation Area
4 Working area (see Measuring Points > Working area)
5 User Menu

The user menu is shown as soon as you have successfully logged in.
6 Alarms bar: shows the number of pending message book entries in the current project

Overview on all message book entries and option to acknowledge the pending message book entries: view > 
Alarms

Note: The screen in the User tab is structured accordingly. Details on the screen in the Project tab can be found 
in the respective chapter.

Related links
Measuring Points Tab
Project tab
User Tab
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4.3 User Menu
If you are logged into the NIVUS WebPortal, you will find the user menu in the top right-hand corner of the menu 
bar.

Abb. 4-9: User Menu

When you open the user menu, you can edit your personal user settings. These are
• Log Out: Here, you can

- log out of the NIVUS WebPortal
- set the time after which you are automatically logged out of the NIVUS WebPortal

• User Profile: your user profile is saved on the NIVUS Identity Server. To edit the user profile click on User Pro-
file > Edit Profile. You then will be redirected to the NIVUS Identity Server. Here, you can
- change, download or delete your personal data
- change your password
Password requirements: at least 8 characters, at least 1 uppercase letter, at least 1 lowercase letter, at least one 
special character
- set up two-factor authentication

• User Actions: Here you can call up your user actions over a specific time range.
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4.4 Input Options
There are many configuration options in NIVUS WebPortal. The following table provides an overview on the 
possible input options.

Tab. 4-6: Input Options

Image Function Input

Input field Enter free text

Opens a dropdown menu Select option

Opens the calendar Open calendar, then select date and time 
or mark and overwrite value

Number field

Count numerical value up or down by 
using the arrow keys
or
Mark and overwrite value

Opens a selection window
or
Opens a configuration window

Select an option
or
Configure value, e. g. message thresholds

Deletes a selected option  call up with mouseover, then click

Checkbox Activate or deactivate function or option

Colour input field, opens the colour 
palette

Open the colour palette and select colour
or specify HSB value
or specify RGB value
or specify hexadecimal colour code
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Erste Schritte und Projektbearbeitung

5 First Steps and Project Processing

5.1 Create and open initial Project
In order to use the NIVUS WebPortal it is necessary to create your own customer project.

Prerequisite(s)
 You have received an email including the link for initial access to the NIVUS WebPortal.

Procedure

1. Open initial access by using the link

 The NIVUS WebPortal opens presenting the initial screen.
2. Enter the user name

 The user must be a valid email address.
 This first user is automatically given administrator rights.

3. Click Create
 The project is now created which may take a while. After this the success message is shown.
 You will receive an email confirmation including a link you can use to create your personal password 

(e-mail address = user name).
4. Close NIVUS WebPortal (Internet browser)
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5. Create password:
- Open the function using the link in the confirmation email
- Enter the password
 Password requirements: at least 8 characters, at least 1 uppercase letter, at least 1 lowercase letter, 

at least one special character
- Repeat the password
- Confirm with Set Password

 The password is created.
 The success message opens.

6. Open project:
- Click Back to Login
 The start screen opens

- Enter the user name
- Enter the password

- Click Login

 Your project will open up in NIVUS WebPortal with the main screen.

After Completing This Task

Add device(s)
Optional: activate licence(s) for additional services

Related links
Main Screen
Add new device

5.2 Start NIVUS WebPortal

Procedure

1. Open web browser (use HTML5 browser, recommended: Google Chrome, Internet Explorer is not suppor-
ted)

2. Type https://www.nivuswebportal.com into the address line of the browser and confirm with Enter
 The login mask of the NIVUS WebPortal opens.

3. Enter the user name
4. Enter the password
5. Click Login

 If the user has access to multiple projects: the start screen of the NIVUS WebPortal including the list of 
projects is called up.

 If the user has access to one project: the NIVUS WebPortal main screen opens.
6. If the user has access to multiple projects: select a project from the list.

Result

 The NIVUS WebPortal main screen opens.
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5.3 Activation of Licences for Additional Services
To activate the functions of additional services, the corresponding licence must be activated in the NIVUS 
WebPortal.

The activation of licences differs according to the following licence types:

5.4 Change Project
If your user account has access to multiple projects you can change between the projects. The following 
sequence describes the procedure.

Procedure

1. Reload NIVUS WebPortal: Press F5 on the keyboard

 NIVUS WebPortal goes back to the start screen.
2. Select the desired project from the projets list

Result

 The NIVUS WebPortal main screen opens in the selected project.

Tab. 5-7: Activation of Licence Types

Licence Type Description Activation through Procedure see

Device Licence

Licence for a specific function 
on a specific device, linked to 
the serial number of the 
device.

Customer
Activate Measuring 
Point or Device Licence

Measuring Point Licence Licence for a certain service 
on a measuring point. NIVUS or customer

Project Licence Licence for a project-related 
service. NIVUS or customer Activation of Licences 

for Additional Services
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5.5 Reset Password
If you can no longer log in to the NIVUS WebPortal because you have forgotten your password, you can reset your 
password.

Procedure

1. Open the web browser (use HTML5 browser, recommendation: Google Chrome, Internet Explorer is not 
supported)

2. Type https://www.nivuswebportal.com into the address line of the browser and confirm with Enter
 The login mask of the NIVUS WebPortal opens.

3. Click Forgot Password
4. Enter the e-mail address you use as your user name and confirm with Submit

 You will receive an e-mail containing a link to the NIVUS  Identity Server
5. Open the link

 You will be redirected to the NIVUS Identity Server.
6. Enter a new password

 Password requirements: at least 8 characters, at least 1 uppercase letter, at least 1 lowercase letter, at 
least one special character.

7. Repeat the new password
8. Confirm with Set Password

 The execution of the action is confirmed.
9. Open the desired application

Target Procedure

NIVUS Identity Server Open the link in the confirmation.

NIVUS WebPortal Type https://www.nivuswebportal.com into the address line of the browser 
again and confirm with Enter
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WebPortal Messstellen

6 Measuring Points Tab
The > Measuring Points tab is subdivided into 3 sections:

Function Bar
• Functions to create and to edit the measuring points
• Functions to call up the device values (process values of the device PVs)
• Option to export device values
• Time Filter

Navigation Area
• Measuring points overview containing all measuring points created in the project
• Devices list containing all devices created in the project
• Option to select the measuring point of which data is to be shown in the working area

Working Area
• Basic content:

- Indication of measuring points on a map
- Measuring Point Configuration
- Log (only for trained personnel): log data of NivuFlow and NivuFlow Mobile devices
- Licence
- Message Book
- Measuring point values as visualisation
- Measuring point values as chart
- Files and Reports

• For devices with NIVUS SIM card and remote access function:
- Remote Access

Related links
Function Bar
Navigation Area
Working Area
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6.1 Function Bar

Overview Menu Options
> Measuring Points

Abb. 6-10: Function Bar in the Measuring Points tab

1 Group Device
2 Group Measuring Point
3 Group View
4 Group Time Filter
5 Group Actions
6 Group Links
7 Group Alarm View

Note: The group Alarm View is shown only if the Alarms view is opened in the working area.

Group Device

Abb. 6-11: Group Device

1 Only active if a new device configuration has been created for the customer by NIVUS which has not yet been 
added to a project. Opens the Select device window to create a new device in the current project.

2 Opens the Select project window to move the device selected in the devices list (Navigation Area) to a diffe-
rent project.
If a measuring point is selected in the navigation area the device linked with this measuring point will be 
moved.

Note: The activated licences for additional services at a measuring point are part of the measuring point and will 
not be moved. The activated device licences are part of the unit and will be moved with the device.
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Group Measuring Point
The functions 2, 3 and 5 refer to the measuring point selected in the navigation area. If a device is selected in the 
navigation area the functions refer to the measuring point which is linked with the device.

Abb. 6-12: Group Measuring Point

1 Opens the Create new measuring point window
2 Opens the Select device window to link a device with the selected measuring point

Note: If a device is selected in the navigation area the newly selected device is assigned to the linked measuring 
point.

3 Removes the selected measuring point - device link
4 Opens the Create new campaign window to create a campaign for the grouping of measuring points
5 Opens the Select campaign window to assign the selected measuring point to a (different) campaign within 

the current project

Group View

Abb. 6-13: Group View

1 Shows / hides (highlighted blue = shown) the device values in the measuring point overview / devices list 
(navigation area)

2 Shows /hides (highlighted blue = shown) the according PV range in the > Visualisation and > Hydrographs 
views

Group Time Filter

Use the time filter to narrow down values shown in the working area (e. g. in a chart or in a value table) covering a 
certain period.

Calculation of the Time Area:

• End Time as configured (2)
• Start Time = End Time (2) - (Unit (4) * Duration (5)
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Abb. 6-14: Group Time Filter

1 Shifts the source time to one interval earlier
The interval results from the settings in (4) and (5).

2 Input field for the source time (= end time) of the period to be considered
3 Opens the calendar
4 Opens the dropdown menu to select the interval unit
5 Input field to specify the interval duration
6 Shifts the source time to one interval later

The interval results from the settings in (4) and (5).
7 Sets the current time as the source time and loads the time range
8 Optional: loads the time area

Note: If you load the time area the process values will be reloaded in the current view.
Note: If you extend the time area loading the process values may take a little longer.

Group Actions
Here you can export process values or files related to the measuring point.

Abb. 6-15: Group Actions

1 Exports the process values of the measuring point selected in the navigation area over a certain time area 
(time filter) as csv file
Configure time zone cultural area / language of the export file see Configuration of CSV Export Files

2 Active only when a file is selected in the > Files and Reports working area: exports the selected file
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Group Links

Abb. 6-16: Group Links

Opens the Cross-Measurement Place Hydrograph Module with extensive functions for the configuration of 
charts (additional service at extra charge)

Group Alarm View
The group is shown as soon as you open the Alarms view in the working area.

Here you can call up the message book entries of the selected measuring point to be displayed in the workspace 
and filter them at the same time. The selected option is highlighted blue.

Abb. 6-17: Group Alarm View

1 Calls up all history message book entries from the selected measuring point over the selected time area (time 
filter). These are message book entries with a time stamp in the past.

2 Calls up all pending message book entries of the selected measuring point. These are message book entries 
that are currently active (coming without leaving).

3 Calls up all pending acknowledgements of the selected measuring point. These are message book entries 
subject to acknowledgement that are not acknowledged.
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6.2 Navigation Area

The navigation area is structured as follows:
• Overview on all measuring points created in the project. > Measuring Points
• Devices list containing all devices available in the project > Devices

In the navigation area you can
• call up data and information on a measuring point in the working area,
• create additional measuring points (licences required),
• link a device to a measuring point,
• create campaigns to group measuring points within the campaigns,
• move a measuring point to a different campaign.

Observe the following notes:
• The devices are created by NIVUS and are saved in NIVUS WebPortal for you. You must add these devices to 

your project. The device configurations in NIVUS WebPortal cannot be edited.
• If you wish to expand your project by additional devices you need to place an according order. As soon as you 

have received your order confirmation specifying the additional devices by email you can add these devices to 
the project.

• A device must always be linked with a measuring point to enable the recorded device values to be 
transmitted to NIVUS WebPortal and to record the values there as measuring point values.

• The both tabs are synchronised. When you switch over between > Devices and > Measuring Points the link of 
the last device / the last measuring point selected is called up each.

• The views in the working area always refer to the last selected measuring point. If in the navigation area the 
> Devices tab is opened and a device is selected (marked blue) then data and information on the linked measu-
ring point is shown in the working area.

• The campaign General is available by default. As soon as you create a new measuring point this measuring 
point is assigned to the General campaign.

Related links
Activate Project Licence
Link Device to a Measuring Point
Create Campaign
Move Measuring Point
Edit Measuring Point Data
Add new device
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6.2.1 Devices

6.2.1.1 Devices List
In the > Devices navigation area you will find the devices list containing all devices available for the 
project. Selecting a device here will indicate data and information on the linked measuring point in the 
working area.

Abb. 6-18: Navigation Area: Devices List

1 Selection menu for the navigation area
The selected tab is marked blue.

2 Full text search
3 Sort function
4 Devices List
5 Selected device (blue frame): the data on this device is shown in the working area
6 Device Information
7 Time of latest data transmission

Note: If the clock symbol is displayed in red, then the last data transmission was too far in the past.
Note: Here you can check the connection status of the device to NIVUS WebPortal. When the device has set up 
a connection to the NIVUS WebPortal and this connection is established, the time stamp is updated in the trans-
mission cycle of the device.
8 Name of the measuring point the device is linked to
9 Symbol of the device type 
10 Device name = serial number

Related links
Device data
Device Types
Link Device to a Measuring Point
Add new device
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6.2.1.2 Device data
Device information can be indicated in the devices list as well as in the measuring points list. You can identify the 
type of device information by the symbols.

The according device values (process values of measuring point PVs) can be indicated optionally (menu option 
View > Device Values).

Tab. 6-8: Device Information Overview

Representation Device Information Description Device Value Unit

Connection Status

Red: No Connection.
Black: The device has set up a connec-
tion to the NIVUS WebPortal and this 
connection is established. If the unit 
values are displayed, then the time stamp 
is shown and updates itself in the unit's 
transmission cycle.

Date and time of 
latest data trans-
mission

Field strength with 
GSM data transmission

Strength of the signal transmitted by the 
unit
(PV: GSM-Signal)

dBm

Network Connection -

Power Supply: Battery 
/ Reachargeable

Battery voltage
(PV: Battery) V

Power Supply not from 
Battery / Rechargeable -

Temperature
Temperature of internal temperature sen-
sor
(PV: Temperature)

°C

Humidity Humidity
(PV: Humidity) %
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6.2.2 Measuring Points

6.2.2.1 Measuring Points Overview
In the > Measuring Points navigation area you can find a measuring points overview containing all 
measuring points created in the project.

Abb. 6-19: Measuring Points Overview

1 Selection menu for the navigation area
The selected tab is marked blue.

2 Full text search
3 Sort function
4 Measuring points overview
5 Selected measuring point (blue frame): the data and information on this measuring point are shown in the wor-

king area.
6 Device data of the linked device (8)
7 Time of latest data transmission
8 Link to a device, the serial number of the device is shown
9 Symbol label of a measuring point
10 Name of measuring point
11 Campaign (= group of measuring points) open: the measuring points of the campaign are shown.

The campaign General is available by default. If you should require more campaigns then these must be crea-
ted.

12 Campaign closed
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Related links
Create Campaign
Move Measuring Point
Edit Measuring Point Data

6.2.2.2 Create Measuring Point

Prerequisite(s)
 You have one free measuring point licence.
 You have administrator rights.

Procedure

1. Click Measuring Point > New

 If a licence must be assigned to the measuring point, the Select Licence window opens, otherwise the 
Create New Measuring Point window opens.

2. Optional, assign licence if requested:

- Select Licence
- Confirm with OK
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3. Configure Measuring Point:

- Enter the name of the measuring point
- Open the drop-down menu and select the device that is to be operated with the measuring point
- Open drop-down menu and select the type of device
 The process variables are automatically created to match the device type at the measuring point. The 

assignment measuring point - process variable is final and cannot be changed later. You can edit the 
individual process variables.

- Click Create

 The success message opens.
4. Confirm with OK

Result

 The new measuring point is created and is shown under the campaign General and is shown in the measuring 
points overview.

After Completing This Task

Assign device with the measuring point
Optional: Activate licence(s) for extra service(s) at the measuring point
Optional: Move measuring point to other campaign
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6.2.2.3 Create Campaign
The campaign General is available by default. You can create further campaigns under which you can 
group the measuring points.

Prerequisite(s)
 You have administrator rights.

Procedure

1. Click Measuring Point > Create Campaign

 The Create new campaign dialogue window opens.
2. Specify a nam for the campaign

3. Click Create
 The window will close.
 The success message opens.

4. Confirm with OK

 The success message closes.
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Result

 The new campaign is shown in the measuring point overview.
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6.2.2.4 Move Measuring Point
You can move measuring points from one campaign to another one. The following sequence describes 
the basic procedure.

Prerequisite(s)
 You have administrator rights.

Procedure

1. In the measuring point overview select the measuring point

 Once the devices list is open you can select the device which is connected with the desired measuring 
point.

 The measuring point is marked (blue frame).
 The views in the working area show the data or information on the measuring point.

2. Click Measuring Point > Move
 The Select campaign dialogue window opens.

3. Select campaign
Page 37



Measuring Points Tab
4. Confirm with OK
 The window will close.
 The success message opens.

5. Confirm with OK

 The success message closes.

Result

 The measuring point is moved to the previously selected campaign and is shown accordingly in the measuring 
point overview.
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6.2.2.5 Rename Campaign

Prerequisite(s)
 You have administrator rights.

Note: The campaign General is available by default and cannot be edited.

Procedure

1. In the Navigation Area open the Measuring Points tab

2. Move the mouse over the campaign until the  symbol appears and then click
 The Edit campaign dialogue window opens.

3. Overwrite the name of the campaign

4. Click Save
 The window will close.
 The success message opens.

5. Confirm with OK

 The success message closes.
Page 39



Measuring Points Tab
Result

 The campaign is shown with its new name in the measuring point overview.

6.2.3 Link Device to a Measuring Point

Prerequisite(s)
 You have administrator rights.

Note: You can link a device to a measuring point which already has an existing device - measuring point link. In 
such a case the original link will be removed and is replaced by the new link.

Procedure

1. In the navigation area open the Measuring Points tab

 The measuring points overview is shown.
2. In the measuring point overview select the measuring point

 The measuring point is marked (blue frame).
 The views in the working area show the data or information on the measuring point.

3. In the function bar click Measuring Point > Link Device
 The Select Device window opens.
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4. Select device

5. Confirm with OK
 The Select Device window is closing.
 The success message opens.

6. Confirm with OK

 The success message closes.
 The link is created but is not yet shown in the Navigation Area.

7. Reload NIVUS WebPortal to indicate the measuring point in the measuring point overview:
Press F5 on the keyboard and log in with the project again
or  use the user menu to log out and log in with the project again

Result

 In the navigation area the link is shown in the measuring point overview as well as in the devices list.

 Should the measuring point be already linked to a device this link then is removed.
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6.2.4 Add new device
It is possible to add new devices to your customer project later. In such a case it is necessary to add the 
according devices to the project once to make them available in the devices list and to make sure all 
other functions are available in the NIVUS WebPortal. The following sequence describes the basic 
procedure.

Prerequisite(s)
 You have placed an order for an additional device at NIVUS and received the order confirmation by e-mail.
 You have administrator rights.

Note: You can create a new measuring point for the device directly while adding and create the according link bet-
ween device and measuring point (see step 6). In this case, the PVs for the device type are automatically created 
at the measuring point. Alternatively, you can link the device to an existing measuring point or to no measuring 
point.
Remember: If the device type and the measuring point configuration do not match exactly, the data for which there 
is no assignment of device input to a process variable will be lost.
Remember: If device and measurement place are not linked there is no data exchange possible between device 
and NIVUS WebPortal.

Procedure

1. In the Functions Bar click Device > Add

 The Select Device window opens and shows the devices previously not used in any project.
2. Select device

3. Confirm with OK
 If necessary, the Select Licence window opens, otherwise the Select Measuring Point window opens.
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4. Optional step, only available if required: Select any licence from the list to assign it to the device

 The Select measuring point window opens.
5. Confirm with OK
6. Edit the device-measuring point link using the following options:

7. Confirm with OK
 Device and possibly measuring point are created (loading time approx. 1 - 2 min). A success message is 

shown subsequently.
8. Confirm with OK

Link to Procedure

of an existing measuring point Activate Link to measuring point and select measuring point.

of a new measuring point Activate Create measuring point and specify a measuring point 
name in the input field below.

of no measuring point Activate No measuring point.
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Result

 The new device is shown in the devices list.

 A created link between device and measuring point is indicated in the devices list as well as in the measuring 
points overview.

6.2.5 Shift Device
Should you have access to multiple projects then you can shift devices between the projects. The follo-
wing sequence describes the procedure.

Prerequisite(s)
 You have administrator rights.

Note: If for the target project there is a not yet activated measuring point licence available it is possible to create a 
new measuring point for the device directly while shifting and to create the according link between device and me-
asuring point (see step 6). In this case, the PVs for the device type are automatically created at the measuring point. 
Alternatively, you can link the device to an existing measuring point or to no measuring point.
Remember: If the device type and the measuring point configuration do not match exactly, the data for which there 
is no assignment of device input to a process variable will be lost.
Remember: If device and measuring point are not linked there is no data exchange possible between the device 
and NIVUS WebPortal.
Note: Note that activated licences for additional services at the measuring point are part of the measuring point. If 
a device is shifted, then these additional services remain at the original measuring point in the source project and 
are not shifted with the device to the target project.

Procedure

1. In the navigation area open the Devices tab
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2. In the navigation area select the device
 The device is marked (blue frame).

3. Click Device > Move to Project
 The Select project window opens.

4. Select target project

5. Confirm with OK
 The Select measuring point window opens.

6. Edit the device-measuring point link using the following options:

7. Confirm with OK
 The success message opens.

8. Confirm with OK

 The device is deactivated in the source project , the change is not yet shown in the navigation area, ho-
wever.

Link to Procedure

of an existing measuring point Activate Link to measuring point and select measuring point

of a new measuring point Activate Create measuring point and specify a measuring point name in 
the input field below

of no measuring point Activate No measuring point
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9. Reload NIVUS WebPortal to indicate the device changes in the source project and in the target project:
Press F5 on the keyboard and log in with the NIVUS WebPortal again
or  use the user menu to log out and log in with the NIVUS WebPortal again

Result

 The device is removed from the source project.

 In the target project the shifted device is shown in the devices list.

 Once a link between device and measuring point has been created in the target project, this is shown in the 
devices list as well as in the measuring points overview.

6.2.6 Remove Measuring Point - Device Link

Prerequisite(s)
 You have administrator rights.

Procedure

1. In the navigation area select the measuring point - device link:

In the devices list select the device with the respective link
or  In the measuring point overview select the measuring point with the respective link

 The device / the measuring point is marked (blue frame).
2. In the functions bar click Remove Device Link

 The success message opens.
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3. Confirm with OK

 The success message closes but the change is not yet shown in the Navigation Area, however.
4. Reload NIVUS WebPortal to show the device changes:

Press F5 on the keyboard and log in with the NIVUS WebPortal again
or  use the user menu to log out and log in with the NIVUS WebPortal again

Result

 The measuring point - device link is removed and the change is shown in the measuring point overview as 
well as in the devices list.
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6.3 Working Area
In the working area you can call up and edit detailed data and information of the measuring points 
created in the project.

You can call up various views in the working area.

The following views are available:

Note: When you open the NIVUS-WebPortal only the > Map view is available in the working area. Select any me-
asuring point from the navigation area to call up all further available views. You are not authorised for the hidden 
views. If a measuring point is greyed out there is no respective licence activated for this measuring point.

Tab. 6-9: Views in the Working Area

View Refers to Description Remarks

Map
all measuring points 
created in the pro-
ject.

If the coordinates are saved: 
indication of the measuring 
point locations

Standard view to open the NIVUS 
WebPortal.

Alarms
the measuring point 
selected in the navi-
gation area.

Display of Message Book 
Entries

Optionally available extension 
module (at extra charge and for 
authorised users only).

Visualisation
the measuring point 
selected in the navi-
gation area.

Visualisation of measuring 
point values (measuring point 
PVs) in a process image

Optionally available extension 
module (at extra charge and for 
authorised users only).

Hydrographs
the measuring point 
selected in the navi-
gation area.

Representation of measuring 
point values as hydrographs 
in a chart

Optionally available extension 
module (at extra charge and for 
authorised users only).

Log
the device selected 
in the navigation 
area.

Log Data Log data is created for NivuFlow 
Mobile and Nivu Flow devices.

Measuring point 
configuration

the measuring point 
selected in the navi-
gation area.

Option to indicate and to edit 
measuring point data (incl. 
measuring point PVs), confi-
guration of hydrographs and 
configuration of templates for 
the automated creation of 
reports (hydrograph reports, 
event reports, DWEA event 
reports)

To edit the sub-sections Hydro-
graphs and Hydrograph Report 
the extension module Hydrogra-
phs must be unlocked.
To edit the sub-sections Event 
Report and DWA Event Report 
the extension module Files and 
Reports must be unlocked.

Files and 
Reports

the measuring point 
selected in the navi-
gation area.

Option to indicate and export 
the linked files

Optionally available extension 
module (at extra charge and for 
authorised users only).

Licences
the measuring point 
selected in the navi-
gation area.

Indication of licenses for all 
purchased services and 
option to activated these

Remote Access
the device selected 
in the navigation 
area.

Remote access to devices 
with remote access function

Optionally available additional 
service (subject to a charge)
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6.3.1 Map

6.3.1.1 Overview Map View

The > Map view shows within a freely configurable map section the positions of the measuring points of which the 
coordinates are saved.

The measuring point coordinates are transmitted to NIVUS WebPortal either by the device (NLG and NFM) or you 
save them in this view > Measuring Point Configuration.

Abb. 6-20: Working Area: > Map View

1 Opens the > Map view
2 Selection menu for the views
3 Selected map section
4 Marks the position of a measuring point
5 Marks the position of the measuring point selected in the working area

Note: If you select a measuring point / a device in the navigation area the according mark will be centered on 
the map and its colour changes to yellow.
Note: If you select the marking of a measuring point on the map it will be centered on the map and its colour 
changes to yellow. The according measuring point is marked in the navigation area (blue label).
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6.3.1.2 Change Map Section

Procedure

1. If required, zoom the map section to the desired level:

Move the mouse cursor over the overview map and use the mouse wheel
or  click the + or - buttons in the overview map to zoom step by step

2. Pan the map section if required

- Move mouse over the map section and click left
 The mouse cursor changes to crosshairs.

- Pan the map section with the left mouse key pressed

6.3.2 Alarms
In the > Alarms view (= Message Book) the message book entries from the selected measuring point are 
shown.

Prerequisites:
• The user is authorised for the Alarms sub-section.
• Data was or is transmitted to the NIVUS WebPortal from the selected measuring point.
• The process variables are configured accordingly (message thresholds and / or reactions).

Related links
Path to the Message Book Entry
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6.3.2.1 Basics of Message Book Entries
Message book entries may vary in terms of message type and status. You can filter the message book 
entries in the message book table accordingly.

6.3.2.1.1 Message Types
Message book entries triggered by process variables vary in terms of message types. The message type results 
from the reaction that causes the message book entry.

The message type is symbolically labelled as follows:

6.3.2.1.2 Status of Message Book Entries
The status of a message book entry refers to its acknowledgement requirement. Message book entries triggered 
by a process variable may be subject to acknowledgement. The requirement to acknowledge a message book 
entry results from the reaction that causes the message book entry.
The status of message book entries is symbolically labelled as follows:

Tab. 6-10: Message Types

Labelling Message Type

Warning Message

Error Message

Operating message

None

Tab. 6-11: Status of Message Book Entries

Labelling Status

Subject to acknowledgment, not acknowledged

Subject to acknowledgement, acknowledged

None Not subject to acknowledgement
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6.3.2.2 Overview Alarms View

The > Alarms view is subdivided into 2 sections.

The Message Book Table always shows message book entries from the measuring point selected in the naviga-
tion area over a defined time range (time filter). You can narrow down this view further.
• In the function bar > Alarms View you can optionally narrow down the screen to

- the pending message book entries. These are message book entries that are currently active (coming without 
leaving)

- the pending acknowledgements. These are messages subject to acknowledgement that are not 
acknowledged.

• Using the filter function in the working area, you can also filter by
- Message Type
- Status of Message Book Entries

Important: Limit value violations are valid for 30 minutes. This means that as soon as a limit value violation has 
occurred but the according process values cannot be transmitted to the NIVUS WebPortal instantly due to an in-
terrupted connection and hence need to be reloaded later, then the according message book entries will be created 
and shown in the message book table for a maximum of 30 minutes. No more message book entry will be created 
once this period has expired.

If a message book entry is selected in the message book table (marked blue) the respective Detail View is shown:
• Indication of message and properties of the message book entry
• Options to acknowledge and to comment a message book entry subject to acknowledgement
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Abb. 6-21: Working Area: > Alarms View

1 Selection menu for the views, here: the > Alarms view is opened.
2 Message book table (= overview of message book entries) with the columns:

PV Type: Symbol label of the PV type that has created the message book entry
Station: If the message book entry is part of a station: station name
Name: Name of the process variable that has created the message book entry
Message Type: Symbol label of the message type
Time: Time stamp of the message book entry
Message: contains the device name and possibly more information
Status: Only for message book entries subject to acknowledgement: Symbol label of message status 
(acknowledged / not acknowledged)
Comment: Comment created during acknowledgement (input field (10))
ID (available only if Alarms View > Pending Entries Einträge is selected in the functions bar): ID of the mes-
sage book entry, provided by the system
Project: Project name
Plant: Should the device that has created the message book entry be part of a plant: Name of the plant
Path: Location of the process variable in the data project

3 Selected message book entry shown in the detail view (9)
4 Filter by message type (warning message, error message, operating message)
5 Filter by status (acknowledged, not acknowledged)
6 Resets the filters
7 Opens the window to show / hide the columns
8 Number of data sets in selected time range (time filter)
9 Detail view of the selected message book entry

If you select an entry in the message book table the respective detail view is shown.
10 Input field for a comment to be saved with acknowledgement. The comment appears in the message book 

table, column Comment.
11 Shown only for message book entries subject to acknowledgement that are not acknowledged: acknowledges 

the message book entry
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Note: If you have narrowed down the message book table to the pending acknowledgements and you ack-
nowledge a message book entry here, then this message book entry disappears from the message book table. 
This message book entry is then only displayed under Alarms View > Message Book.
12 Properties of the selected message book entry including the specifications

Message Type
Time: Time stamp of the message book entry
Station: If the message book entry is part of a station: station name
Status: Status of the message book entry
Acknowledged By: First name and second name of the user who acknowledged the message book entry
Acknowledged On: Time stamp of acknowledgement

6.3.2.3 Filtering Options for Message Book Entries
Filtering Criteria for Message Book Entries:

• Time Stamp of Message Book Entries
• Active-Status of Message Book Entries
• Message Type
• Status of Message Book Entries
This results in the following options for filtering the message book entries:

Tab. 6-12: Filtering Options for Message Book Entries

Option Procedure

Call up the message book entries of a 
measuring point and at the same time fil-
ter them according to the pending 
(= active) message book entries

Tab Measuring Points > Navigation Area: select measuring point > 
view Alarms > Functions bar: Group Alarms View > Pending 
Entries > Functions bar: set Time Filter

Call up the message book entries of a 
measuring point and at the same time fil-
ter them according to the pending ack-
nowledgements

Tab Measuring Points > Navigation Area: select measuring point > 
view Alarms > Functions bar: Group Alarms View > Pending Ack-
nowledgements > Functions bar: set Time Filter

Call up historical message book entries 
of a measuring point over a specific time 
range and then filter them

Tab Measuring Points > Navigation Area: select measuring point > 
view Alarms > Functions bar: Group Alarms View > Message 
Book > Functions bar: set Time Filter > Working area: filter accor-

ding to message type  or status 
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6.3.2.4 Call up Message Book Entries
You can call up the message book entries shown in the table in the workspace and filter them at the same 
time. In this way, you can specifically narrow down the message book entries displayed. The following 
sequence describes the possible options and the corresponding procedures to call up certain message 
book entries.

Procedure

1. In the measuring point overview select the measuring point

 Once the devices list is open you can select the device which is connected with the desired measuring 
point.

 Measuring point is highlighted (blue frame).
 All views in the working area show the data or information on the measuring point.

2. Open Alarms tab
 In the function bar the menu option Alarm View is shown.
 The currently selected and displayed option is highlighted blue.

3. Call up desired Message Book Entries:

Result

 The message book table is reloaded and the selected message book entries are called up.

Target Procedure

Call up all message book entries over a 
specific time range.

Function Bar > Alarm View > Message Book
Function Bar > Time Filter > narrow down time range

Optional: In the working area filter by message type 

Optional: In the working area filter by status 

Call up all message book entries that are 
currently active (coming without leaving).

Function Bar > Alarm View > Pending Entries
Function Bar > Time Filter > narrow down time range

Call up all message book entries subject 
to acknowledgement that are not ack-
nowledged.

Function Bar > Alarm View > Pending Acknowledgements
Function Bar > Time Filter > narrow down time range
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6.3.2.5 Sorting Options of Message Book Entries
By default, the message book entries are sorted in ascending order by time stamp.

You can change the order in which the message book entries are displayed depending on one feature at a time. 
To do this, click on the corresponding column heading and then on the symbol  or .

6.3.2.6 Acknowledge and Comment Message Book Entry
You can acknowledge and optionally comment device-specific message book entries subject to 
acknowledgement directly in the NIVUS WebPortal. The following sequence describes the procedure.

Prerequisite(s)
 A measuring point is selected in the Navigation area (highlighted blue).
 The > Alarms view is opened in the working area.

Procedure

1. Optional: call up Function Bar: Group Alarms View > Pending Acknowledgements to reduce the number 
of message book entries shown

2. Optional: filter message book entries by message type
3. In the message book table select a message book entry

 The message book entry is marked (highlighted blue).
 The detail view of the message book entry is shown.

Tab. 6-13: Sorting Order of individual Columns

Column  ascending  descending

Time current message book entry > oldest message 
book entry

oldest message book entry > current message 
book entry

Station
Message
Status
Plant

alphabetical Z > A alphabetical A > Z
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4. Specify comments if required
5. Click Acknowledge

Result

 The message book entry is acknowledged and commented.

Note: If you have narrowed down the message book table to the pending acknowledgements and you ack-
nowledge a message book entry here, then this message book entry disappears from the message book table. 
This message book entry is then only displayed if you select in the functions bar > Alarms View > Message Book 
in the respective time range.

6.3.3 Visualisation
In the > Visualisation view the device values of the measuring point (measuring point PVs) selected in 
the navigation area (marked blue) are visualised in a process image.

Preconditions:
• The user is authorised for the Visualisation sub-section.
• The Visualisation module is unlocked for the selected measuring point (optional extension module available at 

extra charge).
• A process image for the measuring point is available (additional service Art.-No. SNI0BILD100000).
• There are device values available.

The path to the process image:
• If you acquire the additional service Process Image (Art.-No. SNI0BILD100000) the process image by NIVUS 

will be loaded into the customer project and then is instantly available for all authorised users.
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6.3.3.1 Overview Visualisation View

Abb. 6-22: Working Area: > Visualisation View

1 Selection menu for the views, here: the > Visualisation view is opened.
2 Visualisation of measuring point PVs in a process image
3 PV area: the PV area is indicated only when View > PV Table is activated (highlighted blue) in the function bar.
4 PV table with containing all PVs used in the visualisation and the columns

Type: Labelling of the PV type
Name of the process variable
Short Name of the process variable
Measurement Range of the process variable
Process Value
Facility: if the device is assigned to a facility: name of the facility

5 Calls up the selected process variables (highlighted blue) in the chart view
In the chart view there are the following functions available: time filter, mathematical operations (total and inte-
gral)

6 Opens the window to show / hide individual columns
7 Number of data sets in the PV table
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6.3.3.2 Call Up History Values
The following sequence describes how to call up historical process values of one or more measuring 
point PVs in a chart.

Procedure

1. In the measuring point overview select the measuring point

 Once the devices list is open you can select the device which is connected with the desired measuring 
point.

 The measuring point is marked (blue frame).
 The views in the working area show the data or information on the measuring point.

2. In the working area open the Visualisation tab
3. If required call up in the PV area: in the function bar click View > PV Table

 In the function bar the function is highlighted blue and the PV overview is shown in the working area.
4. Select process variable(s)

 The process variable(s) is / are marked (highlighted blue).
5. Click History Values

 The History Values window (chart) is opened. The selected process variable(s) is / are created in the 
chart.

6. Specify time range
- Open the calendar and select the end time of the desired time range

- Select unit and duration of the desired time range
- Click Load
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Result

 The chart will be redrawn covering the selected time range.

Tip: In this view you can use all other chart functions (mathematical operations, zoom time range).

6.3.4 Hydrographs
In the > Hydrographs view the device values transmitted from a measuring point (measuring point PVs) 
are represented as chart.

Preconditions:
• The user is authorised for the Hydrograph sub-section.
• There are device values available.

Per default a chart refers to a measuring point and shows the PVs of this measuring point as graph. You can confi-
gure the chart in the > Measuring Point Configuration > Hydrographs tab.

More options for evaluation and representation can be implemented as additional service at extra costs. If you 
should require corresponding services please contact NIVUS.

Related links
Overview Configuration of Hydrographs
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6.3.4.1 Overview Hydrographs View
The figure below shows the Hydrographs view by using an example chart. The options shown depend on the 
configuration and hence may vary.

Abb. 6-23: Working Area: > Hydrographs View

1 Y-Axe(i)s = Value Axe(i)s, relate to entire chart or one graph each
2 Selection menu for the views, here: the > Hydrographs view is opened.
3 Chart
4 Graph of a process variable
5 Marker: value description of the process variable at the point in time where the mouse cursor is
6 Scroll bar, here: time range defined by using the time filter is narrowed further
7 Visible only when the indicated time range is narrowed by using the scroll bar: resets the time range to the time 

filter
8 Point in time where the mouse cursor is
9 X-Axis = Time Axis
10 PV legends: details on all process variables shown in the chart as graph

Click on legend: highlights the graph within the chart
Detailed description see Fig. PV Legend

11 Activates / deactivates the mathematical functions totalise or calculate Integral (activated = highlighted blue)
12 Exports the process values of the hydrographs in the selected chart over a certain time area (time filter) as csv 

file
13 Opens the column selection to show / hide the columns in the process values overview (14) ein- / auszublen-

den
14 Process values overview: overview on all archived process values of the measuring point PVs created in the 

chart covering the selected time range (time filter) using the Time Stamp column and one extra column for 
each pro process variable
The PV area is indicated only when View > PV Table is activated (highlighted blue) in the function bar.

15 Number of data sets in selected time range (time filter)
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Abb. 6-24: PV Legend

1 Name of the process variable
2 Name of higher measuring point
3 Shows / hides the graph in the chart
4 Optional: moves the graph vertically within the chart
5 Function available only for service technicians
6 Optional: statistic values

Related links
Overview Configuration of Hydrographs

6.3.4.1.1 Zoom Time Range
Use the zoom function to narrow down the indicated time range of the chart while viewing. To do so use 
the scrollbar or the mouse.

Zoom with the Mouse

Procedure

1. Move the mouse cursor over the chart

2. With the left mouse key pressed move the mouse over the time range within the chart to zoom
 While zooming the zoom range is shown in light red.
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Result

 Based on the settings of the time filter the time range is narrowed further and is indicated in the chart.

 The indicated time range is highlighted in the scroll bar above the chart.

Note: If you wish to reset the time range you need to reload the time filter in the function bar or click Show all.

Zoom with the Scrollbar

Procedure

1. Move the mouse cursor over the scrollbar

 Sliders will appear on both ends of the scrollbar.

2. Move the mouse cursor over a slider
 The mouse cursor changes to a double-headed arrow.

3. Move the slider with the left mouse key pressed

 The time range is narrowed. The narrowed time range is represented in the chart. The scrollbar is indicated 
bright within the narrowed time range.

 The zoomed range is shown on the timeline.
Note: If you wish to reset the time range click on Show all.
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6.3.4.1.2 Performing Mathematical Operations

Calculating Totals
The totals function calculates the total per process value over a selected time range.

Abb. 6-25: Calculating Totals

Procedure

1. Click the totals symbol

 The function is activated and the totals symbol is highlighted blue.
2. With the left mouse key pressed mark the time range within the chart which is to be used for totalising

 The time range will be highlighted red in the chart.

Result

 The totals per process value are shown above the chart.
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Calculate Integral
The integral function calculates the integral per graph over a selected time range.

Abb. 6-26: Calculate Integral

Procedure

1. Click the integral symbol 

 The function is activated and the integral symbol is highlighted blue.
2. With the left mouse key pressed mark the time range within the chart which is to be used to calculate the 

integral
 The time range will be highlighted red in the chart.

Result

 The integrals per graph are shown above the chart.
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6.3.5 Log
In the view > Log you will find the log data of the device that is selected in the navigation area. Log data is created 
for NivuFlow Mobile and NivuFlow devices.

6.3.6 Measuring Point Configuration
The > Measuring Point Configuration view comprises the measuring point data, the configuration of 
hydrographs and reports configuration.

Contents and Functions of the Subsections:
• The Measuring Point Data comprise

- the measuring point information (can be edited),
- the geographic positon of the measuring point (can be edited),
- the PV overview including the process variables created on the measuring point. Here you can select the 

process variables to edit their configuration and you can create calculation values for the measuring point.
• Hydrographs: here you can configure the chart that is to be shown in the > Hydrographs view.
• Hydrographs Report: Here you can configure a template for creating the diagram of the measuring point as a 

PDF file. Based on this template, the PDF files are automatically created cyclically and sent by e-mail to specific 
users.

• Event Report: Here you can configure a template for the automated creation of annual reports. This template 
applies to both event reports and DWA event reports. You can call up the reports created in the > Files and 
Reports view.

• DWA Event Report: Here you can activate the creation of DWA-compliant monthly reports. DWA event reports 
are based on the same configuration as the event reports. You can call up the reports created in the > Files and 
Reports view.

Authorisations

Related links
Edit User Configuration

Tab. 6-14: Required authorisations for the subsections of the measuring point configuration

Subsection Required Authorisation

Configuration of Hydroraphs Hydrographs

Configuration of Hdrographs Reports Hydrographs and Files and Reports

Configuration of Event Reports Files and Reports

Configuration of DWA Event Reports Files and Reports
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6.3.6.1 Overview Measuring Point Configuration View

The > Measuring Point Configuration view refers to the measuring point selected in the navigation area.

The following Figure shows the subsections. You can find detailed information on the subsections in separate 
descriptions.

Abb. 6-27: Overview > Measuring Point Configuration View

1 Measuring point data
2 Opens the configuration of hydrographs
3 Opens the > Measuring Point Configuration view
4 Opens the configuration of templates for hydrograph reports
5 Opens the configuration of templates for event reports
6 Opens the configuration of templates for DWA event reports

Note: The creation of event reports and DWA event reports is based on the same template. If a template for event 
reports is configured, then this is displayed under Event Report and is also valid for the creation of DWA event 
reports. If only a template for DWA event reports is configured, then this is displayed under DWA Event Report.
7 Will undo all unsaved changes in the measuring point data (incl. PV configuration), configuration of hydrogra-

phs and reports configuration
8 Saves all entries or changes in the measuring point data (incl. PV configuration), configuration of hydrographs 

and configuration of templates for reports

Related links
Measuring Point Data
Overview Configuration of Hydrographs
Configuration of Hdrographs Reports
Configuration of Event Reports and DWA Event Reports
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6.3.6.2 Measuring Point Data

The measuring point data comprise the measuring point information, the geographic information and the process 
variables of the measuring point selected in the navigation area. You can edit the measuring point information as 
well as the geographic position. Moreover, you can create calculation values and select process variables to edit 
their configuration.

Abb. 6-28: Working Area: > Measuring Point Configuration View > Measuring Point Data

1 Name of measuring point
2 Short name of measuring point
3 Input field to describe e. g. location
4 Activates / deactivates the coordinates fields (5)

If GPS PVs are available at the measuring point the coordinates are transmitted from the device to the NIVUS 
WebPortal and then are displayed in the coordinates fields (5). In this case the function cannot be edited.
If GPS pvs are not available at the measuring point the coordinates can be detected in NIVUS WebPortal only 
manually. In such a case you need to activate the function and to specify the coordinates in the coordinates 
fields (5).
If the internal coordinates parameters set in the device vary from the real location, you can activate the func-
tion and correct the coordinates (5) here (correction is not transmitted to the device).

5 Input fields for the measuring point coordinates 
6 Input field for a new calculation value
7 Creates the calculation value
8 Overview on process variables created for the measuring point.

When you select a process variable here the pv configuration opens and allows for editing.
You cannot add or delete process variables, however.

9 Name of the Process Variable
10 Symbol label of the PV type
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11 Indicates the active-status of the process variable (here not editable)

: Active

: Deactivated

Related links
Types of PVs
Edit Process Variable
Configuration of Process Variables
Activate / Deactivate Process Variable

6.3.6.3 Edit Measuring Point Data
The following procedure describes how to edit name and position of a measuring point. You can find 
more on how to edit individual process variables of a measuring point or how to create a calculation value 
in separate descriptions.

Abb. 6-29: Edit Measuring Point Configuration

Procedure

1. In the measuring point overview select the measuring point

 Once the devices list is open you can select the device which is connected with the desired measuring 
point.

 The measuring point is marked (blue frame)
 The views in the working area show the data or information on the measuring point.

2. In the working area call up the Measuring Point Configuration view
3. Change the desired option
4. Click 

 The changes will be saved.

Related links
Edit Process Variable
Configuration of Process Variables
Create and configure a Calculation Value
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6.3.6.4 Edit Process Variable
You can edit the process variables which are created for a measuring point. The following sequence 
describes the basic procedure.

Note: A process variable is effective only as soon as it is activated. The active status of a process variable is shown 
in the pv overview. Open the pv configuration to edit the active status.

Procedure

1. In the measuring point overview select the measuring point

 Once the devices list is open you can select the device which is connected with the desired measuring 
point.

 The measuring point is marked (blue frame).
 The views in the working area show the data or information on the measuring point.

2. In the working area open the Measuring Point Configuration tab
 The process variables of the measuring point are shown in the bottom area.

3. Select Process Variable
 The Edit Process Variable window opens.

4. Change the desired options
 The configuration options depend on the PV type. You can find detailed information on the configuration 

options of the various PV types in a separate chapter.
5. Click Close

 The window is closing, the changes (incl. message thresholds and reactions) are not yet saved.
6. In the working area top left click the save symbol.

 All changes will be saved.

Result

 The configuration of process variables has been changed.
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Related links
Configuration of Process Variables
Activate / Deactivate Process Variable

6.3.7 Configuration of Process Variables
You can edit the configurations of the PV types Measured Value, Message and Counter. Moreover, you 
can create Calculation Values. The PV configuration options depend on the PV type. The PV configura-
tion also includes the message threshold configuration for analogue process variables.

Note: The process variables of the measuring point depend on the type of device that is to be used at the measu-
ring point and are created during the measuring point configuration. The assignment of measuring point - process 
variables is final and cannot be changed later i. e. it is not possible to create other process variables than calcula-
tion values and process variables cannot be deleted.

The table below provides an overview on all subsections of the PV configuration.

Related links
Calculation Values

Tab. 6-15: Subsections of PV Configuration

View / Window Possible Functions / Options1 Open

PV Configuration / 
Window Edit Process 
Variable

Edit PV information,
Activate / deactivate PV,
Configure value range and unit,
Only for calculation values: formula configuration,
Overview on message thresholds,
Open message threshold to edit,
Create message threshold,
Delete message threshold.
Assign reaction to PV,
Remove reaction from PV,
Open reaction matrix,

In the navigation area select 
measuring point or device > in 
the working area open Mea-
suring Point Configuration 
view > in the PV overview 
select PV

Message Threshold 
Configuration / Window 
Edit Message 
Thresholds

Configure message threshold,
Activate / deactivate message threshold,
Assign reaction to message threshold,
Remove reaction from PV,
Open reaction matrix.

Window Edit Process 
Variable > Message 
Thresholds > 
or
Window Edit Process 
Variable > Message 
Thresholds > select message 
threshold

Reaction matrix 
(= overview on all reac-
tions created in the pro-
ject)

Assign Reaction to a Message Threshold or a PV.
Window Edit Process 
Variable or Edit Message 
Threshold > Reaction > 

1.Depending on type of PV
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6.3.7.1 Activate / Deactivate Process Variable
The following sequence describes how to activate a deactivated process variable. Follow the same procedure to 
deactivate an activated process variable. 

Procedure

1. In the measuring point overview select the measuring point

 Once the devices list is open you can select the device which is connected with the desired measuring 
point.

 The measuring point is marked (blue frame).
 The views in the working area show the data or information on the measuring point.

2. In the working area open the Measuring Point Configuration view
 The PV overview is shown in the bottom section of the working area.

3. Select PV

 The Edit Process Variable window opens.
4. Check the box under Standard > Active

5. Click Close
 The Edit Process Variable window is closing and the active status is indicated by a grey check mark in 

the PV overview. The modification is not yet saved.
6. In the working area click the save symbol.

 The change is saved.
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Result

 The process variable is activated.

 The active status is indicated in the PV overview by a blue check mark.

6.3.7.2 Process Variable: Configuration Options
The configuration options depend on the type of PV. Below you can find a list and a description of all 
options.

The configuration of PVs is divided into groups. In the following table you can find the assignment of PV types to 
the available configuration groups. 

Standard

Tab. 6-16: Configuration Groups of PV Types

PV Type Group Standard Group Common Group Functions

 Measured Value x x --

 Message
x -- Description see Functions of 

the PV Type Message

 Counter x x Description see Functions of 
the PV Type Counter

 Calculation Value x x Description see Functions of 
the PV Type Calculation Value

Description for all types 
of PVs see Standard

Description for all types 
of PVs see Common

Tab. 6-17: PV Configuration: Standard

Name Description Entry

Active Active-status of PV : Activated
: Deactivated

Name Name of the process variable Free text

Short Name Short name of the process variable Free text

Description Input field for additional information Free text

AKZ Input field for AKZ label Free text
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Common

Functions of the PV Type Message

Tab. 6-18: PV Configuration: Common

Name Description Entry

Decimal Places Decimal places of the process 
value Numerical value

Minimum Lower limit of the value range 
(= lower limit of process value) Numerical value

Maximum Upper limit of the value range 
(= upper limit of process value) Numerical value

Unit Unit of the process value Click  to open the units selection and 
double-click to select.

Message Thresholds
Input field for a new message 
threshold and overview on 
message thresholds

Click  to create a new message threshold
or
select a message threshold from the mes-
sage threshold overview to edit this threshold

Mode (available only for 
NLG and NLC devices with 
available process coupling)

Signal of the connected sensor
Options:
0 -20 mA
4 -20 mA

Tab. 6-19: PV Configuration: Functions of the PV Type Message

Name Description Entry

Change PV Status PV status change of all PVs of the same sta-
tion when a limit value is violated

Options:
None: no PV status change
Maintenance: PVs are set to PV sta-
tus Maintenance

Logic Reporting logic between device input (On / Off) 
and PV (True / False)

: On (1) = True (1)
Off (0) = False (0)

: On (1) = False (0)
Off (0) = True (1)

Reaction for Enter Reaction in case of reaching the upper mes-
sage threshold

Click  to open the reaction matrix 
and select the reaction with double 
click.

Text for Enter
Text that is written into the message book or 
transmitted with remote alarming as soon as 
the upper message threshold is reached.

Free text

Reaction for Leave Reaction in case of reaching the lower mes-
sage threshold

Click  to open the reaction matrix 
and select the reaction with double 
click.

Text for Leave
Text that is written into the message book or 
transmitted with remote alarming as soon as 
the lower message threshold is reached.

Free text
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Functions of the PV Type Counter

Functions of the PV Type Calculation Value

Tab. 6-20: PV Configuration: Functions of the PV Type Counter

Name Description Entry

Counter Type

Options:
Continuous: counter counts continuously
Daily Reset: counter will be reset on daily 
change

Daily Change
Relevant only if Counter Type = Daily 
Reset: point in time when the counter will be 
reset

Click  to open the calendar and to con-
figure a point in time or to overwrite a 
point in time in the input field.

Step Value

Value corresponding to a pulse at the coun-
ter.
Example: one impulse of a rain gauge corre-
sponds to 0.1 mm --> Step Value = 0.1; 
counter unit = mm

Numerical value

Step Value Unit Required specification if the PV unit and the 
unit of the counter are different.

Click  to open the units selection and 
double-click to select.

Calculation Type Calculation of the process value
Options:
Differential
Integral

Tab. 6-21: PV Configuration: Functions of the PV Type Calculation Value

Name Description Entry

Process Variable Process variable which is to be 
included into the calculation.

Click on  to open the PV overview and select 
PV with a double click.

Aggregate Function Select from list

Calculation Interval Basis for calculation time and calcu-
lation period Select from list

Formula Automatically configured calcula-
tion formula -

Time Zone Time zone in which the calculation 
is executed. Select from list

Archiving Storage method of the calculation 
value in the database

Options:
None: the calculation value is not saved.
Change: the calculation value is saved as soon 
as it changes.
Device Cycle: data is saved depending on the 
transmission cycle of the unit. This means that 
the process value is saved in the database with 
a time stamp according to the interval parame-
terised on the unit.
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Related links
Calculation Values
Message Thresholds
Reactions

6.3.7.3 Calculation Values
With the help of calculated values, you can use the process values of a process variable for certain stati-
stical evaluations.

6.3.7.3.1 Basics on Calculation Values
For a calculation value, a calculation formula is applied to the process values of a process variable over a defined 
period of time at a specific point in time.

The calculation formula is automatically created from the following freely selectable parameters:
• Process Variable
• Aggregate Function
• Calculation Interval

The calculation time and calculation period in the set time zone result from the calculation interval (see the follo-
wing table and figure).

• Time Zone

Tab. 6-22: Calculation Intervals of Calculation Values

Calculation Interval Calculation Time Calculation Period

1 Hour Each full hour One hour before the calculation time

2 Hours Each full even hour 2 hours before the calculation time

4 Hours Every 4 hours starting from 00:00 hrs 4 hours before the calculation time

8 Hours Every 8 hours starting from 00:00 hrs 8 hours before the calculation time

12 Hours Every day at 00:00 and 12:00 o'clock 12 hours before the calculation time

1 Day Every day at 00:00 o'clock 24 hours before the calculation time

1 Week Every Monday at 00:00 o'clock One week before the calculation time

1 Month On the 1st of each month at 00:00 o'clock One month before the calculation time

1 Year On the 1st of January of each year at 00:00 
o'clock One year before the calculation time
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Abb. 6-30: Calculation Period

1 1. Calculation Time
2 Period over which the calculation value is calculated at the first calculation time.
3 2. Calculation Time
4 Period over which the calculation value is calculated at the second calculation time.

: Process values saved in NIVUS WebPortal

Note: If no process values are available for the calculation period at the calculation time, then the calculation is 
repeated in shorter intervals until process values are available.

Return of calculation values:
• Always as floating-point number
• Always in the basic unit of the process variable

Use of Calculation Values:
• Use in Charts (> Hydrographs)
• More possible uses can be implemented as additional service at extra costs. If you should require correspon-

ding services please contact NIVUS.

Related links
Process Variable: Configuration Options
Page 77



Measuring Points Tab
6.3.7.3.2 Create and configure a Calculation Value

Procedure

1. In the measuring points overview select the measuring point

 Once the devices list is open you can select the device which is connected with the desired measuring 
point.

 Measuring point is highlighted (blue frame).
 All views in the working area show the data or information on the measuring point.

2. In the working area open the Measuring Point Configuration tab
 The overview on the measuring point PVs is shown in the bottom area.

3. Specify a name for the calculation value
4. Click 

 The calculation value is saved and is shown in the PV overview.

5. Select the calculation value in the PV overview
 The Edit Process Variable window opens.

6. Click Process Variable >  and select PV with double click
 The process variable will be saved as variable for calculation.

7. Select Aggregate Function
 The calculation formula is automatically configured and displayed under Formula.

8. Select Calculation Interval
 The calculation time and calculation period result from the calculation interval.
 The calculation interval is taken over into the calculation formula.

9. Select the Time Zone in which the calculation is to be executed
10. Select Archiving
11. Edit other options if required
12. Click Close

 The window will close. The PV configuration is not yet saved.
13. In the working area click the save symbol 
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Result

 The calculation value is saved and configured.

Related links
Basics on Calculation Values

6.3.7.3.3 Example Calculation Values

Daily value of a flow

Target of the calculation: The flow rate (m3) of the last day in the time zone CET (Central European Time).

This results in the following configuration:

Maximum level within one week
Target of the calculation: The maximum level (m) within the last week in the time zone CEST (Central European 
Summer Time).

This results in the following configuration:

Tab. 6-23: Example configuration of a calculation value: Daily value of a flow

Option Configuration Explanation

Process Variable PV Measured Value Q Input/Flow Rate (l/s)

Aggregate Function Integral
The integral of a flow rate (l/s) returns 
the flow rate in the basic unit m3.

Calculation Interval 1 Day The calculated value is calculated daily 
at 00:00 o'clock over the last 24 hours.

Formula Configured by the system

Time Zone UTC+1

Tab. 6-24: Example configuration of a calculation value: Maximum level in one week

Option Configuration Explanation

Process Variable PV Measured Value Level (m)

Aggregate Function Max

Calculation Interval 1 Week The calculated value is calculated every Monday at 
00:00 o'clock over the last 7 days.

Formula Configured by the system

Time Zone UTC+2
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6.3.7.4 Message Thresholds

6.3.7.4.1 Basics on Message Thresholds
Message thresholds mark the transition from normal status to disturbance and possibly trigger a reac-
tion.

The message threshold is defined as follows:
• Current Measurement Value - Comparative Operator - Limit Value

As soon as an message threshold is reached, exceeded or deceeded this is considered as limit value violation.

Example:
• Current measured value: PV Level = 10 m

Comparative operator: >
Limit value: 9 m
10 m > 9 m = true, Process Condition = Disturbance

• Current measured value: PV Level = 8 m
Comparative operator: >
Limit value: 9 m
8 m > 9 m = false, Process Condition = Normal

When you create or edit a message threshold observe the following notes:
• Assignment PV : Message Threshold = 1 : n: you can create multiple message thresholds for one process 

variable. One message threshold is valid always for one process variable only.
• Active Status: you can activate or deactivate each message threshold. A limit value violation can trigger a reac-

tion only if the message threshold is activated.
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6.3.7.4.2 Overview on Message Thresholds
The overview on the message thresholds can be found in the PV configuration (Edit Process Variable window). 
The overview on message thresholds shows the message thresholds available for a process variable. Here you 
can add more message thresholds and you can call up existing message thresholds for editing.

Note: A message threshold is effective only as soon as it is activated. To view or to edit the active status of a mes-
sage thresholds open the configuration of message thresholds.

Abb. 6-31: Overview on Message Thresholds

1 Input field to specify a name for a new message threshold
2 Overview on message thresholds including all message thresholds available for the selected process variable.

Call up message threshold for editing: select message threshold with left mouse key.
3 Opens the message threshold configuration (Edit Message Threshold window) to create a new message 

threshold.
4 Shown only on mouseover: deletes the selected message threshold
5 Comparative operator and defined limit value
6 Name of message threshold

6.3.7.4.3 Message Threshold: Configuration Options
In the message threshold configuration each configure an message threshold and the reaction that is to occur in 
case of a limit value violation.

Standard

Tab. 6-25: Message Threshold Configuration: Standard

Name Description Entry

Name Name of message threshold Free text

Short Name Short name of message threshold Free text

Description Input field for additional information Free text
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Message Threshold

Tab. 6-26: Message Threshold Configuration: Message Threshold

Name Description Entry

Active Active-status of message threshold Activate / deactivate

Limit Value Limit value of message threshold Numerical value

Unit Unit of limit value Click  to open the units selection 
and double-click to select.

Comparative Operator
Comparative operator of message threshold 
between
current measurement value - limit value

Select from list

Reaction for Enter
Links the message threshold to the reaction 
that is triggered as soon as a limit value vio-
lation occurs.

Click  to open the reaction matrix 
and select the reaction with double 
click or create new reaction.

Text for Enter

Text that is written into the message book if 
required and / or transmitted with remote 
alarming as soon as a limit value violation 
occurs. 

Free text

Reaction for Leave
Links the message threshold to the reaction 
that is triggered as soon as the limit value 
violation is over.

Click  to open the reaction matrix 
and select the reaction with double 
click or create new reaction.

Text for Leave

Text that is written into the message book if 
required and / or transmitted with remote 
alarming as soon as the limit value violation 
is over.

Free text

Time-Limited Activates / deactivates the message 
thresholds only for a limited time slot. Activate / deactivate

Validity Start Relevant only if Time-Limited : start of 
time slot

Time

Validity [s] Relevant only if Time-Limited : duration of 
time slot

Time span in seconds

Change PV Status Causes a PV status change in the event of a 
limit value violation. Select from list

Routing

Links the message threshold to a PV for rou-
ting.
Routing: As soon as a limit value violation 
occurs, the system switches to the routing 
PV.

Click on  to open the PV overview 
and select PV with a double click.

Routing Value Value that is written to the routing PV in the 
event of a limit value violation. Numerical value

Substitute Value Value that is written to the PV in the event of 
a limit value violation. Numerical value
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6.3.7.4.4 Create Message Threshold

Procedure

1. In the measuring point overview select the measuring point

 Once the devices list is open you can select the device which is connected with the desired measuring 
point.

 The measuring point is marked (blue frame).
 The views in the working area show the data or information on the measuring point.

2. In the working area open the Measuring Point Configuration view
 The PV overview is shown in the bottom section of the working area.

3. Select PV
 The Edit Process Variable window opens.

4. Click Common > Message Threholds > 
 The Edit Message Threshold window opens.

5. Edit the message threshold configuration, for configuration example see the following figure
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6. Click Close
 The Edit Message Threshold window is closing and the message threshold is shown in the overview on 

message thresholds. The message threshold is not yet saved.

7. In the working area click the save symbol .
 The specifications will be saved.

Result

 The message threshold is created for the PV.

6.3.7.4.5 Change Message Threshold
You can change the configuration of a message threshold. The following sequence describes the basic 
procedure.

Procedure

1. In the measuring point overview select the measuring point

 Once the devices list is open you can select the device which is connected with the desired measuring 
point.

 The measuring point is marked (blue frame).
 The views in the working area show the data or information on the measuring point.

2. In the working area open the Measuring Point Configuration view
 The PV overview is shown in the bottom section of the working area.

3. Select PV
 The Edit Process Variable window opens.

4. Click Common > Message Thresholds > 
 The Edit Message Threshold window opens.

5. Select a message threshold from the overview on message thresholds

 The Edit Message Threshold window opens.
6. Change the desired options
7. Click Close

 The Edit Message Threshold window is closing and the message threshold is shown in the overview on 
message thresholds. The changes are not yet saved.
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8. In the working area click the save symbol.

 The changes will be saved.

Result

 The message threshold is now changed.

6.3.7.4.6 Delete Message Threshold

Procedure

1. In the measuring point overview select the measuring point

 Once the devices list is open you can select the device which is connected with the desired measuring 
point.

 The measuring point is marked (blue frame).
 The views in the working area show the data or information on the measuring point.

2. In the working area open the Measuring Point Configuration view
 The PV overview is shown in the bottom section of the working area.

3. Select PV
 The Edit Process Variable window opens.

4. In the overview on message thresholds use the mouse cursor to click the delete icon of the desired message 
threshold and delete by clicking left

 The message threshold is removed from the overview on message thresholds. The modification is not yet 
saved.

5. Click Close
 The Edit Process Variable window is closing. The message threshold is not yet deleted.

6. In the working area click the save symbol.

Result

 The message threshold is deleted.
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6.3.7.5 Reactions

6.3.7.5.1 Basics on Reactions
Reactions influence and control the processing of messages and remote alarming by triggering other 
events (e.g. creating a message book entry) under certain conditions (such as limit value violations). 
Moreover, reactions may influence a PV status.

Pre-configured reactions are provided by the system (reaction matrix).

If you assign a reaction to a process variable or a message threshold, then observe the following notes:
• Analog PVs: Assignment Message Threshold : Reaction = n : 1: Only one reaction can be assigned to a 

certain message threshold, but you can assign one reaction to any number of message thresholds.
• Digital PVs: Assignment PV : Reaction = n : 2: You can assign a maximum of 2 reactions to a digital 

PV(upper - and / or lower message threshold), but you can assign one reaction to any number of PVs (only pos-
sible in NICOS Studio).

• Message Book Entry subject to Acknowledgement: Reactions can create message book entries that are eit-
her subject to acknowledgement or not. If the reaction is to create a message book entry subject to ack-
nowledgement you must use a reaction with acknowledgement requirement activated.

• Remote Alarming: Reactions can trigger remote alarming. If the reaction is to trigger remote alarming, then 
you must use a reaction with remote alarming activated.

Related links
Path to the Message Book Entry
Path to Remote Alarming

6.3.7.5.2 Reaction Matrix
In the reaction matrix you can find the pre-configured reactions provided by the system.

The reactions differ by the events that trigger them and are not editable. In the reaction matrix you can select a 
reaction with a double click in order to assign it to a process variable or to a message threshold.

The reaction matrix comprises the following columns:

Tab. 6-27: Reaction Matrix

Column Description

Name Describes the intended use of the reaction

Message Type Is shown in the message book (symbol label in the message book) and 
has possibly influence on the PV status symbol label

Delay [s] Delays the activation of the reaction after reaching, exceeding or falling 
below the message threshold (= time in seconds)

Remote Alarming : The reaction triggers remote alarming.
: The reaction does not trigger remote alarming.

Acknowlegement Requirement

: The reaction generates an entry in the message book that must be 
acknowledged.

: The reaction generates an entry in the message book that must not 
be acknowledged.
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6.3.7.5.3 Assign Reaction to PV / Message Threshold
You can assign a reaction to a message threshold / a PV. The following sequence describes the proce-
dure.

Procedure

1. In the measuring point overview select the measuring point

 Once the devices list is open you can select the device which is connected with the desired measuring 
point.

 Measuring point is highlighted (blue frame).
 All views in the working area show the data or information on the measuring point.

2. In the working area open the Measuring Point Configuration view
 The PV overview is shown in the bottom section of the working area.

3. Select PV
 The Edit Process Variable window opens.

4. Only for analog process variables: Click Common > Message Thresholds > 
 The Edit Message Threshold window opens.

5. Assign Reaction for Enter and Reaction for Leave:

- Click Reaction for Enter > 
 The reaction matrix opens.

- Double-click in the reaction matrix to select the reaction
 The reaction matrix is closing.
 The reaction is assigned to the process variable / the message threshold and is shown in the Reaction 

for Enter field. The modification is not yet saved in the database.

- Proceed likewise to assign a Reaction for Leave

6. Only for analog process variables: Click Close
 The Edit Message Threshold window is closing.

7. Click Close
 The Edit Process Variable window is closing.

8. In the working area click the save symbol

Result

 The reaction is assigned to the selected process variable.
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6.3.7.5.4 Separate Reaction from PV / a Message Threshold
You can remove reactions assigned to a message threshold / a PV without deleting the reactions from 
the database. The following sequence describes the procedure.

The following sequence gives an example on how to remove the reaction from an analog PV. Steps 4 an 6 are nor 
required for digital PVs.

Procedure

1. In the measuring point overview select the measuring point

 Once the devices list is open you can select the device which is connected with the desired measuring 
point.

 Measuring point is highlighted (blue frame).
 All views in the working area show the data or information on the measuring point.

2. In the working area open the Measuring Point Configuration view
 The PV overview is shown in the bottom section of the working area.

3. Select PV
 The Edit Process Variable window opens.

4. Only for analog process variables: Click Common > Message Thresholds > 
 The Edit Message Threshold window opens.

5. In the Reaction for Enter field or Reaction for Leave field move the mouse cursor to the delete icon and 
delete by clicking left

 The reaction is removed from the field. The modification is not yet saved.

6. Only for analog process variables: Click Close
 The Edit Message Threshold window is closing.

7. Click Close
 The Edit Process Variable window is closing.

8. In the working area click the save symbol

Result

 The reaction is removed from the selected PV / the selected message threshold, but it is not deleted from the 
database.
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6.3.8 Configuration of Hydrographs

The Configuration of Hydrographs comprises
• the selection of process variables, the values of which are to be represented in a chart (default = line chart) as 

graphs (View > Hydrographs)
• the representation of the individual hydrographs,
• the configuration of help lines and value axes,
• the loading behaviour of the chart.

6.3.8.1 Overview Configuration of Hydrographs

Abb. 6-32: Configuration of Hydroraphs

1 Drop-Down Menu containing all PVs available on the measuring point. Here you can select the process variab-
les which are to be shown as hydrograph in the chart.

2 Adds the selected process variable (1) to the chart.
3 Overview on the process variables shown in the chart as hydrograph.

Here you can select a process variable to edit the accompanying representation parameters in the chart 
(series, guides and value axis).

4 Only visible with mouseover: removes the selected process variable from the chart.
5 Drop-Down menu to determine the loading behaviour of the chart:

Lazy on Zoom/Pan: Data is reloaded if required.
Recommended for charts covering long periods.
Representation of hydrographs: approximation providing more details with higher zoom levels.
All Values up Front: all data is loaded instantly, expect longer loading times for larger amounts of data.
Recommended for charts covering short periods.
Representation of graphs: accurate at any time.

Tip: The order of the process variables in the PV overview (3) is equal to the order of the PV legends and value 
axes in the chart. You can change the order by moving the process variables in the PV overview (3) with the left 
mouse key pressed.
Page 89



Measuring Points Tab
6.3.8.2 Hydrograph: Configuration Options
Below you can find a list of all available options for the configuration of hydrographs.

The options each refer to the selected process variable and hence to their representation within the chart and are 
subdivided into 3 groups.

Tab. 6-28: Configuration of Hydrographs: Series

Name Description Input

Colour

Colour of all representation parame-
ters of the process variable in the 
chart (hydrograph, PV legend, mar-
ker, guides and value axis)

Click the colour field to open the 
colour palette, then select the 
colour.

Series Type Representation of the series Select from list
(Default = Line)

Line Thickness Line thickness of hydrograph in 
pixel Numerical value

Show Bullets Activates / deactivates the indica-
tion of bullets on the hydrograph

: Bullets are shown on the 
hydrograph

Hydrograph is shown without 
bullets

Bullet Size
(only visible with activated bullets) Bullet size in pixel Numerical value

Tab. 6-29: Configuration of Hydrographs: Guides

Name Description Input

Show Guides
Activates / deactivates the guides 
and shows / hides the guides selec-
tion

: Guides are activated and 
available

: Guides are not available

Guides
(only visible with activated guides)

Guides selection to indicate certain 
values in the chart as guides

: Guide is shown in the chart
: Guide is not shown in the 

chart

Limit Values
(only visible with activated guides)

Should message thresholds be defi-
ned for the process variable their 
limit values are shown here. You 
can activate the limit values to show 
them as guides within the chart.

: Limit value is shown in the 
chart as guide

: Limit value is not shown in 
the chart
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Related links
Overview Hydrographs View

Tab. 6-30: Configuration of Hydrographs: Value Axis

Name Description Input

Show Graph Value Axis

Shows / hides a separate value axis 
for the hydrograph in the chart and 
shows / hides the following options 
for the configuration of value axes

: Hydrograph value axis is shown
: Hydrograph value axis is not 

shown

Name
(only visible with the activated 
value axis)

Input field for the axis label within 
the chart Free text

Margin
(only visible with the activated 
value axis)

Distance between value axis and 
Y-axis of the chart in pixel Numerical value

Position
(only visible with the activated 
value axis)

Axis position Select from list

Invert
(only visible with the activated 
value axis)

Activates / deactivates reversed 
scaling : Scaling is reversed

Scaling
(only visible with the activated 
value axis)

Value range of value axis

Select from list with the options:
Automatic: minimum to maximum 
measurement value
Measurement Range: entire mea-
surement range
Manual: free definable value range

Minimum
(shown only if Scaling = Manual) Lower limit of value range Numerical value

Maximum
(shown only if Scaling = Manual) Upper limit of value range Numerical value

Unit Scaling unit Select from list

Draw to End (Only for digital 
process variables)

Draws the hydrograph from the last 
stored process value to the end of 
the displayed time range

Activate / deactivate
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6.3.8.3 Configure Hydrographs
The following sequence provides examples on how to create process variables as hydrographs in a chart 
and how to edit the representation parameters.

Prerequisite(s)
 You have access rights for the Hydroraphs sub-section.

Procedure

1. In the measuring point overview select the measuring point

 Once the devices list is open you can select the device which is connected with the desired measuring 
point.

 The measuring point is marked (blue frame).
 The views in the working area show the data or information on the measuring point.

2. In the working area open the Measuring Point Configuration view
3. Create PV as hydrograph in the chart:

- In the Hydrographs subsection open the drop-down menu and select the process variable that is to be 
shown in the chart as hydrograph

- Click 
 The process variable is moved to the PV overview of the chart and hence is created in the chart as 

hydrograph. The changes are not yet saved.

- For all further PVs repeat step 3
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4. Edit the representation parameters of the hydrograph:
- Select process variable in the PV overview of the chart

 The Edit Hydrograph window opens.
- Optional: edit series

- Optional: activate and select help lines
- Optional: activate and select value axis
- Click Close
 The Edit Hydrograph window is closing. The changes are not yet saved.

- For all further hydrographs repeat step 4

5. Optional: change loading behaviour (standard setting Lazy on Zoom/Pan)

 Changing to All Values up Front provides exact representation of the hydrograph but may require longer 
loading times. Recommended: change only for short periods.
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6. In the working area click the save symbol.

 All changes will be saved.

Result

 The process variable is saved in the chart as hydrograph and the representation parameters are configured.

Remember: Go to the > Hydrographs view to call up the chart.

Related links
Hydrograph: Configuration Options

6.3.9 Configuration of Hdrographs Reports
A hydrographs report is a PDF file of the diagram of a specific measuring point at a specific point in time. Under 
Hydrographs Report you can configure a template for the creation of these PDF diagram files at the selected 
measuring point. Based on this template, the PDF files are automatically created cyclically and sent by e-mail to 
specific users.

The configuration of hydrographs reports includes:
• activation / deactivation of the automated creation of reports
• cycle and frequency of reporting
• the  user(s), who should receive the hydrographs report by e-mail

Observe the following precondition required for the creation of hydrographs reports:
• Automatic reporting is activated (= settings in the hydrographs report configuration).
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6.3.9.1 Chart Report: Configuration Options
Below you can find a list of all available options for the configuration of chart reports.

The options each refer to the selected measuring point and hence to the diagrams created for the selected measu-
ring point. The options are divided into 2 groups.

In the Basic Information you determine at which times a chart report is created and sent.

In the User group you determine the recipients of the chart reports.

Abb. 6-33: Chart Report: User

1 Input field for a user
2 Opens the dropdown menu containing all users created in the project. Select a user as recipient for the chart 

reports here.
3 Assigns the selected user (1) to the recipients of chart reports (4)
4 List with all recipients of chart reports
5 Only visible on mouseover: Removes the user from the recipients list.

Tab. 6-31: Chart Report: Basic Information

Name Description Input

Active Active status of automatic reporting for 
this measuring point

: Automatic reporting is activated
: No Reporting

Start Time Reporting time Time in format hh:mm

Time Zone Time zone in which the start time is to 
be interpreted. Select from list

Execution every Reporting Cycle (= Execution Cycle) Select from list

Every x day
Every x week
Every x month

Reporting frequency based on the exe-
cution cycle Numerical value

Day
Depending on the execution cycle: 
Weekday or day of the month on which 
the chart report is generated.

Weekday: select from list
or
Day of a month: value between 1 and 31
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6.3.9.2 Configure Chart Reports
The following sequence provides an example on how to create and to edit a configuration as a basis for 
the automated creation and sending of chart reports.

Prerequisite(s)
 You have the access rights for the Hydrographs sub-section and for the Files and Reports sub-section.

The following sequence provides an example on how to create and to edit a new configuration for the chart reports 
of a measuring point. If you wish to edit an existing configuration step 4 is not necessary.

Procedure

1. In the measuring point overview select the measuring point

 Once the devices list is open you can select the device which is connected with the desired measuring 
point.

 The measuring point is marked (blue frame).
 All views in the working area show the data or information on the measuring point.

2. In the working area open the Measuring Point Configuration view
3. Open Chart Report
4. Optional: click Create Report Configuration

 The report configuration is opened.
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5. Edit Basic Information:
- If desired, activate or deactivate automatic reporting
- Configure time of execution, execution cycle and frequency as desired

6. Assign recipients of the chart reports:
- Open the dropdown menu under User and select the desired user.

- Click 
 The selected user is transferred to the recipient list.

7. For all other recipients repeat step 6
8. In the working area top left click the save symbol

 All changes will be saved.

Result

 The configuration for the automated creation and sending of chart reports is now created or changed.
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6.3.10 Configuration of Event Reports and DWA Event Reports

For logging stormwater overflow tank events, you can create templates for automatic report generation. Each 
template applies for one measuring point. The following reports can be generated from these templates:
• Event reports for internal customer documentation
• DWA Event Reports are based on DWA specifications and are intended for upload to the DWA portal Storm-

water Overflow Tank Operation

In the templates, you define the contents of the event reports or DWA event reports that are created for the selected 
measuring point. The following events can be logged:
• Duration and frequency of impoundage
• Duration and frequency of overflow
• Overflow Volume

The configuration of templates for event reports and DWA event reports comprises
• the activation / deactivation of the automated creation of event reports under > Event Report

the activation / deactivation of the automated creation of DWA event reports under > DWA Event Report
• the configuration of basic information (output in the header)
• the definition of events to be logged with the following subdivision

- Basic event = tank impoundage
- Sub-event = max. basin level or basin overflow

• the calculation basis of the overflow volume

For DWA event reports additionally configure
• a DWA-compliant file name
The essential features of event reports and DWA event reports are:

Tab. 6-32: Event report and DWA event report: Features

Feature Event Report DWA Event Report

Basis NIVUS Standard, DWA-compliant DWA-compliant, especially for stormwater over-
flow tank operation

Output Format PDF CSV

Generation

Annual reports of the previous year each 
on the 3rd  of January of the following 
year
and
Annual report of the current year on the 
3rd day of each month. If there is an 
annual report from the previous month of 
the same year, it will be overwritten.

Monthly report of the previous month each on 
the 3rd  day of the following month
and
Monthly report of the current month daily at 5.00 
p.m. If there is a monthly report from the pre-
vious day of the same month, it will be overwrit-
ten.

Filing NIVUS WebPortal > Files and Reports NIVUS WebPortal > Files and Reports

File Name Is generated automatically Must be configured DWA-compliant
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6.3.10.1 Validity of Events
If a certain start condition is fulfilled the event is valid and is evaluated as such for reporting. If a certain 
end conditions is fulfilled the end of the event occurs making the event invalid. This end of the event is 
evaluated for reporting.

Note: The basic event is decisive for reporting. Only if a basic element is valid it is possible to evaluate the accom-
panying sub-event for reporting.

Start Condition

The following start condition marks the beginning of an event:
• The process value is greater than the Comparative Value for Start over the duration of the Debounce Time 

for Start.

If the Start condition is fulfilled the event is valid and is evaluated as such for reporting.

The following figure shows a situation where the process value is permanently below the comparative value. The 
Start condition is not fulfilled. No event is occurring.

Abb. 6-34: No Event, Process Value < Comparative Value

The following figure shows an event where the process value rises above the Comparative Value for Start, but 
the Debouncing Time for Start has not been reached. The Start condition is not fulfilled. The event is invalid.

Abb. 6-35: Invalid Event, Process Value > Comparative Value, but shorter than debouncing time
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The following figure shows an event where the process value rises above the Comparative Value for Start and 
the Debouncing Time for Start is exceeded. The Start condition is fulfilled. The event is valid.

Abb. 6-36: Valid Event, Process Value > Comparative Value and debouncing time exceeded

Configuration Example of Start Condition

Configuration:
• Comparative value for start: 0.3 m
• Debouncing time for start: 30 s

This results in the following start condition:
• Process value length is 30 s > 0.3 m

End condition

The following end condition marks the end of an event:
• The process value is smaller than the Comparative Value for End over the duration of the Debouncing Time 

for End.

The following figure shows an event where the process value is permanently above the Comparative Value for 
End. The End condition is not fulfilled. The event remains to be valid

Abb. 6-37: No End of Event: Process Value > Comparative Value
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The following figure shows an event where the process value falls below the Comparative Value for End, but the 
Debouncing Time for End has not been reached. The End condition is not fulfilled. The event remains to be valid

Abb. 6-38: No End of Event: Process Value < Comparative Value, but shorter than debouncing time

The following figure shows an event where the process value falls below the Comparative Value for End and the 
Debouncing Time for End is exceeded. The End condition is fulfilled. The event has ended.

Abb. 6-39: End of Event: Process Value < Comparative Value and debouncing time exceeded

Configuration Example of End Condition

Default configuration based on the end condition:
• Comparative Value for End = Comparative Value for Start - 0.05 m

= 0.3 m - 0.05 m = 0.25 m
• Debouncing Time for End: 30 s

This results in the following end condition:
• Process value length is 30 s < 0.25 m

6.3.10.2 Event Report / DWA Event Report: Configuration Options
Below you can find a list of all available options for the configuration of templates for event reports and DWA event 
reports.

You can find the configuration options under > Measuring Point Configuration > Event Report or under > 
Measuring Point Configuration > DWA Event Report

Note: The creation of event reports and DWA event reports is based on the same template. If a template for event 
reports is configured, then this is displayed under > Event Report and is also valid for the creation of DWA event 
reports. In this case, you only need to configure the file name for the reports to be created and the active status of 
the report creation under > DWA Event Report. If only a template for DWA event reports is configured, then this 
is displayed under > DWA Event Report.

The options each refer to the selected measuring point and hence to the contents of the event reports or DWA 
event reports created for the measuring point. The options are divided into 4 groups.
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The following Basic Information is shown in the report header when the report is created.

In the groups Basic Event - Tank Impoundage and Sub-Event each configure the events (beginning and end of 
event) that are to be logged.

Tab. 6-33: Event Report: Basic Information

Name Description Entry

Active

Active status of automatic reporting for this 
measuring point and all other configuration 
options

Note: Activate creation and configuration 
of event reports under > Event Report. 
Activate creation and configuration of DWA 
event reports under > DWA Event Report.

: Automatic reporting and all 
other configuration options are 
activated

: No Reporting and no confi-
guration possible

Pass-Through Tank Selection of the tank type
Enter X to select the 
pass-through tank, otherwise no 
entry

Intercepting Tank Selection of the tank type Enter X to select the intercepting 
tank, otherwise no entry

Wastewater Treatment 
Plant Name of the wastewater treatment plant Free text

Measuring Device checked Date of last check or review cycle Free text

SO above Number of available or planned storm-
water overflows above Numerical value

SOT above Number of available or planned storm-
water overflow tanks above Numerical value

Special Structure Name of special structure Free text

Location Name of location Free text

Company Name of company Free text

Tab. 6-34: Event report: Basic Event = Tank Impoundage

Name Description Entry

PV for basic event PV for the determination of begin-
ning and end of event Click  and select PV with double click

Comparative value for 
start [m]

Comparative value for beginning of 
event Numerical value

Debouncing time for 
start [s]

Debouncing time in seconds for 
beginning of event Numerical value

Comparative value for 
end [m] Comparative value for end of event Not editable, is computed by the system:

Comparative value for start + 0.05

Debouncing Time for 
End Debouncing time in seconds Not editable,

= Debouncing time for start

PV for max. water level Determination of max. water level Click  and select PV with double click

Debouncing time for 
max. level [s]

Debouncing time in seconds related 
to the max. water level Numerical value
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In the Overflow Volume group configure the according calculation.

6.3.10.3 Configure Templates for Event Reports
The following sequence provides an example on how to create and to edit a template for the automated 
creation of event reports.

Prerequisite(s)
 You have teh access rights for the Files and Reports sub-section.

Tab. 6-35: Event Report: Sub-Event

Name Description Entry

Overflow type
Select from list with the options:
Sewage Overflow
Basin Overflow

PV for sub-event PV for the determination of 
beginning and end of event Click  and select PV with double click

Comparative value for start [m] Comparative Value in meters 
for beginning of event Numerical value

Debouncing time for start [s] Debouncing time in seconds 
for beginning of event Numerical value

Comparative value for end [m] Comparative value in meters 
for end of event

Not editable, is computed by the system:
Comparative value for start + 0.05

Debouncing time for end [s] Debouncing time in seconds 
for end of event Not editable = debouncing time for start

Tab. 6-36: Event Report: Overflow Volume

Name Description Entry

Measurement
Measurement method used 
as calculation basis for over-
flow volume.

Select from list with the options:
Level (h)
Flow (q)

PV PV for calculation of overflow 
volume

Click  and select PV with 
double click

Debouncing time [s] Numerical value

Weir height (w=0) [m]
(Only available for measurement = level) Numerical value

Subtract weir height (w0) from level (h)
(Only available for measurement = level)

Definition of height hV for the 
calculation of the overflow 
volume

: hV = Level - Weir Height

: hV = Level

Weir width (b) [m]
(Only available for measurement = level) Numerical value

Overflow coefficient
(Only available for measurement = level) Numerical value
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The following sequence describes how to create and to edit a new template for the event reports of a measuring 
point. If you wish to edit an existing configuration step 4 is not necessary.

Procedure

1. In the measuring point overview select the measuring point

 Once the devices list is open you can select the device which is connected with the desired measuring 
point.

 Measuring point is highlighted (blue frame).
 All views in the working area show the data or information on the measuring point.

2. In the working area open the Measuring Point Configuration view
3. Open Event Report
4. Optional: click Create Report Configuration

 The report configuration is opened.
5. Edit Basic Information:

- If desired, activate or deactivate automatic reporting
- Mark the basin type (Intercepting Tank or Pass-Through Tank) with an X.
- Overwrite all further basic information depending on the facility
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6. Configure Basic Event - Tank Impoundage:

- Click PV for basic event >  and select PV with double-click
 The PV is accepted for the report configuration.

- Specify comparative value and debouncing time for the beginning of the event
 Comparative value and debouncing time for the end of the event are calculated by the system.

- Click PV for max. water level >  and select PV with double-click
 The PV is accepted for the report configuration.

- Specify the debouncing time for the maximum water level

7. Configure Sub-Event:

- Click PV for sub-event >  and select PV with double-click
 The PV is accepted for the report configuration.

- Specify comparative value and debouncing time for the beginning of the event
 Comparative value and debouncing time for the end of the event are calculated by the system.

8. Configure the calculation basis for the Overflow Volume:
- Open drop-down menu and select the measurement method to use as basis for the calculation

- Click PV >  and select PV with double click
 The PV is accepted for the report configuration.

- Specify the debouncing time for the maximum water level
- Edit all further options

9. In the working area click the save symbol

 All changes will be saved.
 The current settings are automatically saved as a PDF file in the download directory of your browser.

Result

 The template for the automated creation of event reports is now created or changed.

Remember: Go to the Files and Reports view to call up the created monthly and annual reports.

6.3.10.4 DWA Report: Configuration

The following applies for the configuration of templates for DWA event reports:
• If a template for automatic report generation is created under > Event Report, then this is also valid for DWA 

event reports. In this case, configure only the active status and the file name under > DWA Event Report.
• If no template for automatic report creation has been created under > Event Report, then you will find all confi-

guration options for the automatic creation of DWA event reports under > DWA Event Report.
• You must configure the file name for DWA event reports according to DWA specifications. The file name is 

user-specific. You can query the file name in the DWA portal RÜB-Betrieb under FTP Upload > Dateinamen 
für diesen Benutzer
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6.3.10.5 Configure Templates for DWA Event Reports
The following sequence provides an example on how to create and to edit a template for the automated 
creation of DWA event reports.

Prerequisite(s)
 You have the acces rights for theFiles and Reports sub-section.

The following sequence describes how to create and to edit a new template for the DWA event reports of a mea-
suring point. If you wish to edit an existing configuration step 4 is not necessary.

Procedure

1. In the measuring point overview select the measuring point

 Once the devices list is open you can select the device which is connected with the desired measuring 
point.

 Measuring point is highlighted (blue frame).
 All views in the working area show the data or information on the measuring point.

2. In the working area open the Measuring Point Configuration view
3. Open DWA Event Report
4. Optional: click Create Report Configuration

 If no event report template is configured yet: The report configuration opens with all configuration options.
 If a template for event reports is already configured: The report configuration is only opened with the 

DWA-specific options (active status and file name). The remaining configuration options are displayed un-
der > Event Report.

5. If desired, activate or deactivate automatic reporting

6. Enter DWA File Name
 The file name is pre-determined by DWA and is user-specific. You must investigate the file name in the 

DWA portal RÜB-Betrieb under FTP-Upload > Dateiname für diesen Benutzer.
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7. Edit all further options

8. In the working area top left click the save symbol
 All changes will be saved.
 The current settings are automatically saved as a PDF file in the download directory of your browser.

Result

 The template for the automated creation of DWA event reports is now created or changed.

Remember: Go to the Files and Reports view to call up the created monthly and annual reports.

Related links
Configure Templates for Event Reports

6.3.11 Files and Reports
The > Files and Reports view lists all files which are saved in the database and are assigned to the 
measurement point selected in the navigation area.

Prerequisite:
• The user is authorised for the Files and Reports sub-section.

The linked files include:
• Event reports according to customer configuration (tab Measurement Point Configuration > Event Report)
• DWA event reports according to customer configuration (tab Measurement Point Configuration > DWA Event 

Report)
• Periodic reports created automatically with the aid of the SNI0WEBPRUEB add-on.
• Customer-specific reports based on Excel (extra service SNI0BEREXCEL01).

You can download the linked files.

Related links
Configuration of Event Reports and DWA Event Reports

Prerequisite Procedure

No further options are 
shown here.

Open > Event Report. Here you will find the other options that apply to both 
event reports and DWA event reports and you can edit them if necessary.

All further options are 
shown here.

Configure all other options in the Basic Information, for the Basic Event - 
Basin Impoundage, for the Sub-Event and for the Overflow Volume.
Detailed description see Configure Templates for Event Reports
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6.3.11.1 Overview View Files and Reports

Abb. 6-40: Working Area: View > Files and Reports

1 Opens the file categories filter
2 Full text search
3 Sort function by

Name: File name
Type: File format
Created: Date of creation

4 Views selection menu, here: the > Files and Reports view is opened.
5 List of files linked to the measuring point which is selected (highlighted blue) in the navigation area.

The selected file is highlighted blue.
6 Project name
7 File preview: shows the file selected in the files list (5).
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6.3.11.2 Download linked File

Prerequisite(s)
 The Device Overview tab is open.

Abb. 6-41: Download linked File

Procedure

1. Select device from the devices list.

 The device is marked (highlighted blue).
 In the working are the views selection menu is shown.

2. Open > Files and Reports view
3. Select file

 The file is marked (highlighted blue) and is shown in the preview.
4. In the function bar click File / Download Report

Result

 The file is saved in the download directory of the browser.
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6.3.12 Licences
In the > Licences view the licences for additional services activated at the selected measuring point , the 
licences for additional services activated at the selected device and the available licences for additional 
services of the project are displayed. You must activate the licences for additional services once in the 
NIVUS WebPortal at a measuring point or on a device in order to activate the corresponding function.

Note: The following information on licences applies to orders as of 2022. All information on licences from older 
orders can be found in the manual NIVUS WebPortal Rev. 03.

For Measuring Point Licences the following applies:
• Assignment measuring point licence to measuring point = n : 1.
• All licences for the use of the NIVUS WebPortal include one measuring point licence. This allows you to operate 

each unit at at least one measuring point.
• Optionally, you can purchase licences for additional services at measuring points. You can activate licences for 

multiple additional services at one measuring point. This assignment is final and cannot be changed later.
• You can purchase additional measuring point licences for additional measuring points. If you have free measu-

ring point licences, you can create additional measuring points.

For Device Licences the following applies:
• Assignment device licence to device = n : 1.
• A device has at least one SIM card licence.
• Optionally, you can purchase licences for additional services. You can activate licences for several additional 

services on one device. You must then unlock the according function on the device by using the licence code. 
The licence - device assignment is linked to the serial number of the device and is therefore final and cannot be 
changed later.

Related links
Activation of Licences for Additional Services
Device Licences: Licence Code
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6.3.12.1 Overview Licences View
Note: The Licences view always refers to the selected measuring point and to the device at the measuring point. 
Therefore, you can select the measuring point or the linked device in the navigation area to call up all associated 
measuring point licences and device licences.

The figure below shows a > Licences view example by using a measuring point including device with the following 
properties:
• No additional services are activated for the measuring point and no additional services are available.
• There is one additional service activated for the device and there is another additional service available.

Abb. 6-42: > Licences View

1 Navigation area with measuring points overview / devices list
2 Selected measuring point (blue frame)

The licence information shown in the working area refer to this measuring point and to the device at the mea-
suring point.

3 Activated device licences of the device at the selected measuring point
4 Activated measuring point licences of the selected measuring point
5 Overview of the free licences for measuring point-related and device-related additional services of the project
6 Activates a licence for the selected measuring point or the linked device in the NIVUS WebPortal (active only if 

an available licence is selected)
7 Selection menu for the views, here: the > Licences view is opened.
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6.3.12.2 Activate Measuring Point or Device Licence
The following sequence describes how to activate a licence in NIVUS WebPortal by using a device 
licence as example. If you wish to activate a measuring point licence proceed as described previously.

Prerequisite(s)
 You have received the link for initial access to NIVUS WebPortal and you have created your customer project.
 You have received an overview on ordered devices and the according licences via email. In this case the NI-

VUS devices are created in NIVUS WebPortal and the according licences are saved in the NIVUS WebPortal.
 The devices and measuring points haven been created in NIVUS WebPortal for you.
 You have added at least on device to your customer project since before that it is not possible to call up the 

> Licences view (select device) in the working area.
 You have administrator rights.

Important: Each licence can be assigned to a measuring point / a device only once. This assignment cannot be 
changed and cannot be undone. Prior to assignment make sure to have the correct measuring point / the correct 
device selected.
Remember: The Licences view always refers to the selected measuring point and to the device at the measuring 
point. Therefore, you can select the measuring point or the linked device in the navigation area to call up all asso-
ciated measuring point licences and device licences.

Procedure

1. If in the working area only the > Map view is available: Select any measuring point in the navigation area.

 In the working area the > Licences view and all other available views are indicated.
2. Open > Licences view

 In the working area the licences for the measuring point / the device are shown which is selected in the 
navigation area.

3. In the navigation area select the measuring point / the device you wish to assign to a certain licence.
 All licences which can be assigned to the selected measuring point / the selected device are shown in the 

Available field.
 All licences which are previously assigned to the selected measuring point are shown in the Activated 

(Measuring Point) field.
 All licences which are previously assigned to the selected device are shown in the Activated (Device) 

field.

4. Select the desired licence in the Available field.
 The licence is highlighted blue.
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5. Click Activate.
 Measuring point licence: the licence is removed from the Available field and moves to the Activated (Me-

asuring Point) field. The function is unlocked on the measuring point.
 Device licence: the licence is removed from the Available field and moves to the Activated (Device) field. 

The licence key for device licences to unlock the function on the device is shown here as well.

After Completing This Task

Only for device licences: unlock the function on the NIVUS devices by using the licence key (see Instruction Manual 
/ Handbook of the respective device).

6.3.12.3 Device Licences: Licence Code
When you assign a licence code to a device and the activate it, the licence code is shown in the working area in 
the Activated field. This is required in order to unlock the according function on the device (procedure see Instruc-
tion Manual / Handbook of the device).

Note: FTP/SMTP licences for remote data transmission are device licences allowing remote data transmission in-
dependent from the NIVUS WebPortal. These licences must be activated once per device in the NIVUS WebPortal.

Abb. 6-43: Licence for Remote Data Transmission via FTP/SMTP as Example for an activated Device Licence.

1 Licence type (name)
2 Serial number of the device to which the licence is assigned
3 Licence code: you need the licence code to unlock the according function on the device.
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6.3.13 Remote Access
Via remote access, you can access devices with remote access function directly from the NIVUS 
WebPortal.

Prerequisites:
• The device is equipped with a remote access function.
• A remote access licence is activated for the selected device (additional service at extra charge).
• The user has administrator rights.

The following applies for remote access:
• Devices permanently online and connected to NIVUS WebPortal: Remote access is possible at any time.
• Devices that are not permanently online and only connect to the NIVUS WebPortal cyclically: Remote access is 

only possible within a predefined time window. You define the time window by using a Wake Up Command.

The following applies for Wake Up Commands:
• A Wake Up Command is the point in time when the unit connects to NIVUS WebPortal for remote access.
• The Wake Up Command is sent to the device at the next cyclic connection. Therefore, the Wake Up Command 

must be after the next cyclic connection with the device.
• If the Wake Up Command reaches the unit in time and the unit connects to the NIVUS WebPortal for remote 

access at the time of the Wake Up Command, the connection will remain for 10 minutes. You can start remote 
access within this time window. The connection is maintained for the duration of the remote access, even if it 
exceeds 10 minutes.

• You must configure a new Wake Up Command for each scheduled remote access.
• There is always only one active Wake Up Command. If there is a Wake Up for a device and you configure ano-

ther Wake Up command, the original Wake Up command is overwritten.
• If you miss the time window for remote access, then the next opportunity for remote access is after the next 

cyclic connection between the unit and the NIVUS WebPortal. For this you must configure a new Wake Up 
Command.

Configuration Example of a Wake Up Command

Prerequisites:
• Cyclic connection between unit and NIVUS WebPortal: daily at 6.00 p.m.
• Time of configuration: 01.08.2021, 10.00 p.m.

The result is:
• Wake Up Command: 01.08.2021 noon

No connection establishment, no remote access possible!
The Wake Up Command is after the time of configuration but before the next cyclic connection. The Wake Up 
Command will not be sent to the unit until 6.00 p.m. on 01.08.2021. Therefore, the device cannot connect to the 
NIVUS WebPortal on 01.08.2021 at noon .

• Wake Up Command: 02.08.2021 noon
Connection setup on 02.08.2021 at noon , start of remote access possible until 12.10 p.m.!
The Wake Up Command is after the time of configuration and after the next cyclic connection. The Wake Up 
Command is sent to the unit on 01.08.2021 at 6.00 p.m. and the unit connects to the NIVUS WebPortal on 
02.08.2021 at noon  for at least 10 minutes.
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6.3.13.1 Overview Remote Access View
The following illustration shows the Remote Access view using an example configuration of the Wake Up 
Command that has not yet been sent to the device.

Abb. 6-44: Working Area: > Remote Access View

1 Serial number of the selected device
2 Configuration of Wake Up Command
3 Calendar and input field for the date
4 Time selection and input field for the time
5 Time zone (not editable)
6 Sends the configuration of the Wake Up Command to the device
7 Starts remote access

Precondition: there is a connection to the device established.
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6.3.13.2 Configure and Start Remote Access
The following procedure describes an example of how to configure and start remote access for a device 
that connects cyclically to the NIVUS WebPortal. For units with a permanent connection to the 
NIVUS WebPortal, the configuration of the Wake Up Command (steps 4 and 5) is omitted.

Prerequisite(s)
 The device is operated with a NIVUS SIM card.
 You have administrator rights.

Procedure

1. In the navigation area open the Devices tab

2. Select device from the devices list
 The device is marked (blue frame).
 All views in the working area show the data or information on the measuring point to which the device is 

linked.
3. Open Remote Access

 Remote access to the selected unit opens.
4. Configure Wake Up Command ( = time of scheduled remote access):

 The time of the scheduled remote access must be after the next cyclic connection between the unit and 
the NIVUS WebPortal.

- Open calendar and select the date for the Wake Up Command
- Open the time selection and enter the time for the Wake Up Command

5. Click Send
 The Wake Up Command is sent to the device at the next cyclic connection.
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6. Start Remote Access: 

Result

 The configuration interface of the device is called up in the NIVUS WebPortal and you can operate the device 
(see the manual of the device).

Connection between device 
and NIVUS WebPortal Procedure

Cyclic Click on Load Device UI no later than 10 minutes after the time of the 
Wake Up Command.

Permanent Click Load Device UI (possible at any time).
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6.4 Export Device Values
You can export device values recorded on a measuring point over a certain period as a file.

Note: By default, device values are exported as CSV file. You need an according licence if you wish to export to a 
different format.

Procedure

1. In the measuring point overview select the measuring point

 Once the devices list is open you can select the device which is currently connected with the desired me-
asuring point.

 The measuring point is marked (blue frame).
 The views in the working area show the data or information on the measuring point.

2. Specify time range
- Open the calendar and select the end time of the desired time range

- Select unit and duration of the desired time range
- Click Load

3. Export device values:
In the function bar click Actions > Export Data
or  in the working area > view Hydrographs > PV area click Export

Result

 The device values are exported as csv file and are saved in the download directory of your browser.

Related links
Configuration of CSV Export Files
Page 118



NIVUS WebPortal
WebPortal Projekt

7 Project tab
Note: The > Project tab is available only to the user with administrative rights.

In the > Project tab you will find functions and configuration options that are valid for the whole project. This 
includes
• configuring the export file
• creating hydrograph templates
• creating a new project (additional service at extra charge)
• activating project licences for project-related additional services

7.1 Function Bar
> Project

Abb. 7-45: Function Bar in the Project tab

1 Only active if you have purchased a licence for an additional project licence; opens the Create New Project 
window

2 Project tab
3 Licences group: Here you activate the project licences for the measuring point handling or the hydrograph 

module for all measuring points (additional services at extra charge).
The options are only active if a corresponding licence is available for the project but not yet activated.
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7.1.1 Create Additional Project

Prerequisite(s)
 You have acquired an additional NIVUS WebPortal Project License which was activated by NIVUS.
 You have administrator rights.

Procedure

1. Open the > Project tab

2. Click Project > New
 The Create new project window opens

3. Specify a name for the new project

4. Click Create

Result

 The additional project is created, the project configurations are taken over from the original project. You can 
open the new project using the same access data as for the current project.

7.1.2 Activate Project Licence
If you have acquired a project licence for an additional service, you must activate this licence once. Only 
then are the corresponding functions activated.

Prerequisite(s)
 You have purchased a licence for the project for the hydrograph module covering all measuring points or for 

a customer-specific project overview (additional services subject to a charge).
 You have administrator rights.

Procedure

1. Open the > Project tab
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2. Activate Licence

 The success message opens.
3. Confirm with OK

Result

 The additional service is enabled.

7.2 Working Area
In the working area you will find all the configuration options that are valid for the whole project. 

At the top right you will find the following storage options:

• : Saves all entries / changes

• : Undoes all unsaved changes, i. e. all configurations are reset to the last saved state

The working area is divided into the following groups:
• Standard
• Export for the configuration of CSV export files
• Hydrograph Templates for the configuration of hydrograph templates across measuring points

7.2.1 Standard Configurations

Project Licence for Procedure

Cross-Measuring Point Hydrograph Module Click on Function Bar: Licences > Activate Hydrographs

Project Overview Click on Function Bar: Licences > Activate Project Overview

Tab. 7-37: Project > Standard

Name Description Entry

Language Project language, standard texts in the message book are output in 
the project language. Select from list

Show Map Indication of map under Measuring Points > Map : The map is shown.
: The map is hidden.
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7.2.2 Configuration of CSV Export Files
In the > Export group you configure the settings for data export in CSV standard format.

Remember: Start data export under Measuring Points > Function Bar: Actions > Export Data
or under Measuring Points > Working Area: Hydrographs > Export

Tab. 7-38: Project > Export

Name Description Entry

Single 
Date-Time-Column

Number of Columns for Date and 
Time

: Output of date and time in one column
: Output of date and time in in 2 columns

Use fix UTC Offset Calculation basis for the times in 
the export file

: Times are output in the defined time zone
: Times are output based on UTC with or 

without offset

Only available when 
the UTC Offset is 
activated: UTC Off-
set

Select from list

Only available when 
the UTC Offset is 
deactivated: Time 
Zone

Time zone for the times in the 
export file Select from list

Substitution Mode Substitution mode for data gaps

Options:
Zero: substitute value = 0
Substitute Value: replaces the data gap by the 
substitute value
Previous value: replaces the data gap by the 
latest valid value
Next value: replaces the data gap by the next 
valid value

Substitute Value
If Substitution Mode = Substitute 
Value
Input field for the substitute value

Numerical value

Culture Info

Country code of the desired cultural 
area. The country code causes 
adjustments to table formatting and 
language.

Select from list

Field Delimiter Field delimiter in the CSV file Depending on the further processing of the 
export file

Exclude PV Connec-
tionStatus

: The PV ConnectionStatus is excluded from 
data export

: The PV ConnectionStatus is exported
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7.2.3 Configuration of Hydrograph Templates
Using hydrograph templates, you can pre-configure hydrographs for specific process variables.

The following applies for hydrograph templates:
• The identifier for the application of hydrograph templates is the short name of the PV.

If the hydrograph template name and the PV short name match, then the hydrograph template is applied to the 
process variable.

Hydrograph templates are used as follows:
• Existing hydrograph templates to new measuring points: Automatically, i. e. for all process variables at the 

measuring point for which there are corresponding hydrograph templates, the hydrographs are created automa-
tically.

• New or deleted hydrograph templates on existing charts: User-triggered using the Recreate all Hydrogra-
phs function: All charts of all measuring points are recreated based on the hydrograph templates. If new hydro-
graph templates have been created, then the corresponding hydrographs are created in the charts of the 
measuring points. If hydrographs are created in the charts for which there is no hydrograph template, they will 
be deleted from the charts. Manual changes previously made to the charts are also overwritten.
Important: Before executing, make sure that there is no possibility of unintentional data loss.

• Changed hydrograph templates to existing hydrographs: User-triggered using the function Apply Display 
Settings to all Hydrographs: Style changes in the hydrograph templates are applied to all corresponding 
hydrographs at the measuring points. Manual changes previously made to the hydrograph configurations are 
also overwritten.

At the measuring points
• additional hydrographs can be created at any time,
• hydrograph configurations from hydrograph templates can be overwritten.
Page 123



Project tab
Abb. 7-46: Project > Hydrograph Templates

1 Input field for a new hydrograph template
The name of the hydrograph template must be identical to the PV short name of the process variable to which 
the hydrograph template is to be applied.

2 Creates the new hydrograph template
3 Overview of hydrograph templates

Here you can select a hydrograph template to edit it.
4 Shown only on mouseover: deletes the selected hydrograph template
5 Function Apply Display Settings to all Hydrographs: Style changes in the hydrograph templates are applied 

to all corresponding hydrographs at the measuring points.
6 Function Recreate all Hydrographs: All charts of all measuring points are recreated based on the hydrograph 

templates.

Important: Before executing, make sure that there is no possibility of unintentional data loss.
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7.2.4 Hydrograph Templates: Configuration Options
Below you can find a list of all available configuration options for hydrograph templates.

The options are divided into 2 groups.

Tab. 7-39: Configuration of Hydrograph Templates: Data Series

Name Description Entry

Short Name

Name of Hydrograph Template
In order for the hydrograph template to be applied to a spe-
cific process variable, the name of the hydrograph tem-
plate must match the short name of that process variable.

Free text

Colour
Colour of all representation parameters of the process 
variable in the chart (hydrograph, PV legend, marker, gui-
des and value axis)

Click the colour field to open the 
colour palette, then select the 
colour.

Tab. 7-40: Configuration of Hydrograph Templates: Value Axis

Name Description Entry

Show Graph Value Axis

Shows / hides a separate value axis for 
the hydrograph in the chart and shows 
/ hides the following options for the 
configuration of value axes

: Hydrograph value axis is shown
: Hydrograph value axis is not shown

Position
(only visible with the acti-
vated value axis)

Axis Position Select from list

Scaling
(only visible with the acti-
vated value axis)

Value range of value axis

Select from list with the options:
Automatic: minimum to maximum mea-
surement value
Measurement Range: entire measure-
ment range
Manual: free definable value range

Minimum
(shown only if Scaling = 
Manual)

Lower limit of value range Numerical value

Maximum
(shown only if Scaling = 
Manual)

Upper limit of value range Numerical value

Unit Scaling unit Select from list
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7.2.5 Configure Hydrograph Template
The following sequence provides an example on how to create and to configure a hydrograph template.

Procedure

1. Open the > Project tab

2. Specify a name for the new hydrograph template

 The name must be identical to the PV short name of the process variable to which the hydrograph template 
is to be applied.

3. Click 
 The hydrograph template is created and shown in the hydrograph template overview. The hydrograph tem-

plate is not yet saved.
4. Select hydrograph template

 The Edit Hydrograph Template window opens.
5. Configure the hydrograph template as desired

6. Click Close
 The Edit Hydrograph Template window is closing. The hydrograph template is not yet saved.

7. In the working area top right click the save symbol 

Result

 The hydrograph template is saved and configured.
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8 User Tab
Note: The > User tab is available only to users with administrative rights.

The > User tab is subdivided into 3 sections:

Function Bar
• Functions to create and edit the user accounts.

Navigation Area
• Users overview containing all users created in the project.
• Option to select an user. The user configuration of this user is shown in the working area.

Working Area
• Display and editing option of the user configuration, this includes

- general user information
- availability for remote alarming
- access rights

8.1 Function Bar
> User

Abb. 8-47: Function Bar in the User Tab

1 Opens the window Create User
2 Deletes the user selected in the user list
3 Tab User
4 Active only when user configuration has been changed: saves the changes
5 Active only when user configuration has been changed: resets the changes
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8.2 Navigation Area
In the Navigation Area you can find the user list containing all users created in the project. Here you can select the 
user whose configuration is to be displayed in the working area.

Abb. 8-48: Navigation Area: User List

1 User list
2 Full text search
3 Selected user: (blue frame): the information and user rights on this user are shown in the working area
4 User Name
5 Optional: first name and second name of the user
6 Labelling of Active Status

User is activated
User is deactivated

Configuration of active status see working area

Related links
Working Area

8.3 Working Area
In the working area, you can edit the user accounts.

Below you can find a list of all available options for the configuration of users. The options each relate to the 
selected user and are divided into 3 groups.
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Common
Under General you configure the general user information.

Remote Alarming
Under Remote Alarming you can activate the user account for remote alarming by e-mail and /or by SMS. This  
means that the user is notified by email and / or SMS as soon as a process variable creates a message book entry 
and all other conditions for remote alarming are fulfilled. (Remote alarming by SMS = additional service at extra 
charge)

Abb. 8-49: User Configuration: Remote Alarming

1 Activates / deactivates the user for remote alarming via e-mail
2 Activates / deactivates the user for remote alarming by SMS
3 Mandatory if (2) is activated: Input field for the telephone number to which the SMS notification is to be sent.

User Rights

Under User Rights you can
• activate / deactivate the access right to the individual sub-sections for the selected user
• give or take away administrator rights from the selected user

Related links
Authorisations

Tab. 8-41: User Configuration: General

Name Description Entry

Active Active-Status of User : The user is active.
: The user is deactivated.

ID User ID, assigned by the system Not editable

First Name
Last Name First name and second name of the user Free text

Street
City
Zip

User address (no effect on other functions) Free text

Language Additional information (no effect on other functions) Select from list
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8.4 Create User

Prerequisite(s)
 You have administrator rights.

Procedure

1. Open > User tab

2. Click Add
 The Create User window opens.

3. Enter the user name
 The user name must be a valid email address of the user.

4. Open the drop-down menu and select the language for the user interface
 The language settings can be changed by the user at any time.

5. Click Create

Result

 The new user is created and shown in the user overview with the according user name.

 The new user is active but has no access rights.

 The new user receives an e-mail which contains access information.

After Completing This Task

Edit User Configuration
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8.5 Edit User Configuration

Abb. 8-50: Edit User Configuration

Procedure

1. Open > User tab

2. Select the user from the user list
 The user is marked (highlighted blue).
 In the working area, its user configuration is displayed.

3. Optional: activate user
4. Edit desired user information
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5. Optional: Unlock user for remote alarming via e-mail and / or SMS. For remote alarming via SMS: specify 
telephone number.

6. Activate or deactivate desired access rights
7. In the function bar click Save

Result

 The changes are saved in the database.

8.6 Delete User

Procedure

1. Open Users tab

2. Select the user from the user list
 The user is marked (highlighted blue).

3. In the function bar click Delete
 The confirmation prompt opens.

4. Acknowledge the confirmation prompt with Yes
 If you do not wish to remove the user, abort by clocking No.

Result

 The user will be deleted.
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9 Help in Case of Problems
If problems with the NIVUS WebPortal should arise check whether you can solve the problems yourself by using 
the information given in the table below. Should this not be possible contact the NIVUS support.

Tab. 9-42: Fault Table  (Sheet 1 of 2)

Problem Possible Reason(s) Remedy

The NIVUS WebPortal is not 
available

No Internet connection Connect with the Internet

NIVUS knows about the problem Contact NIVUS support, see Sup-
port

User cannot log in to NIVUS 
WebPortal (Invalid username or 
password)

Entered user name or password 
wrong

Enter correct user name and 
password
If required, request a new 
password, see Reset Password

User account is deactivated

Have user account activated by 
user with administrative rights in the 
project available, see Edit User 
Configuration

No data transmission from 
device to the NIVUS WebPortal

Device is not unlocked for the 
NIVUS WebPortal

Unlock the device for the NIVUS 
WebPortal (see Instruction Manual / 
Handbook of the device)

Device battery empty Charge battery

Wrong device assigned to the mea-
suring point

Check serial number, see Measu-
ring Points Overview

Mobile data reception not available Ensure network reception

Data not saved in NIVUS Web-
Portal

Device is not assigned to a measu-
ring point

See Link Device to a Measuring 
Point

No PV available for the device input 
on the measuring point

No data storage available on the 
measuring point

PV is not active See Activate / Deactivate Process 
Variable

The Projects and User tabs are 
not displayed The user has no administrator rights

Have administrator rights assigned 
by user with administrative rights, 
see Edit User Configuration

Tab for a subsection is not 
shown User has no access right

Have access rights assigned by 
user with administrative rights, see 
Edit User Configuration

Button Measuring point > New 
is not active

No free measuring point license 
available

Purchase an additional measuring 
point licence from NIVUS or 
approve a measuring point licence, 
see Remove Measuring Point - 
Device Link

No data shown on the measu-
ring point

Basic system is offline Check connection status (top right)

Wrong time range selected Select correct time range, see 
Group Time Filter
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Measurement Ranges / Sca-
lings and measurement are not 
compatible

Wrong PV Configuration in NIVUS 
WebPortal

Check PV Configuration, see Edit 
Process Variable and Configuration 
of Process Variables

Configuration of Hydrographs is 
not active

User not authorised for
Hydrographs subsection

Have access rights assigned by 
user with administrative rights, see 
Edit User Configuration

No measuring point chart shown 
in the Hydrographs view

The chart is not configured Configure chart and hydrographs, 
see Configure Hydrographs

Wrong time range selected Check selected time range, see 
Group Time Filter

No data was saved in NIVUS Web-
Portal. See above

Report configuration not active User not authorised for Files and 
Reports sub-section

Have access rights assigned by 
user with administrative rights, see 
Edit User Configuration

Button Project > New is not 
active No free project licence available Purchase additional project licence 

from NIVUS

Incorrect presentation of the 
NIVUS WebPortal

Outdated Browser (no HTML5)
Use current browser, preferably 
Google Chrome
(Internet Explorer is not supported)

Incorrect presentation from browser 
cache Flush browser cache

Tab. 9-42: Fault Table (Continued) (Sheet 2 of 2)

Problem Possible Reason(s) Remedy
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